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前言

简介

本章包含使用 PICkit™ 3 编程器 / 调试器前需要了解的一般信息。 本章讨论的内容包
括：

• 文档编排

• 本指南使用的约定

• 保修登记

• 推荐读物

• Microchip 网站

• 开发系统客户变更通知服务

• 客户支持

客户须知

所有文档均会过时，本文档也不例外。 Microchip 的工具和文档将不断演变以满足客户的需求，因此
实际使用中有些对话框和 / 或工具说明可能与本文档所述之内容有所不同。 请访问我们的网站
（www.microchip.com）获取最新文档。

文档均标记有“DS”编号。此编号位于每页底部的页码之前。DS 编号的命名约定为“DSXXXXXA”，
其中“XXXXX”为文档编号，“A”为文档版本。

欲了解开发工具的最新信息，请参阅 MPLAB® IDE 在线帮助。 在 Help （帮助）菜单中选择 Topics
（主题），打开现有在线帮助文件列表。
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文档编排

本文档说明了使用 PICkit 3 作为开发工具在目标板上仿真和调试固件的方法。本手册
内容编排如下：

• 第 1 章 概述——PICkit 3 编程器 / 调试器概述。

• 第 2 章 工作原理——简要描述 PICkit 3 编程器 / 调试器的工作原理。

• 第 3 章 安装——如何安装 PICkit 3 编程器 / 调试器。

• 第 4 章 常规设置——提供关于如何使用 PICkit 3 编程器 / 调试器编程受支持器件
的入门指示信息。

• 第 5 章 PICkit 3 Debug Express——提供关于如何使用 PICkit™ 3 Debug 
Express 的基本信息。

• 第 6 章 故障诊断第一步——故障诊断过程的第一步是确认调试问题以及产生问题
的常见原因。

• 第 7 章 常见问题解答 （FAQ）——提供解决常见问题的信息。

• 第 8 章 错误消息——提供具体的错误消息和一般纠错操作。

• 第 9 章 调试器功能汇总——汇总可用的调试功能。

• 第 10 章 硬件规范——详述 PICkit 3 的硬件和电气规范。

• 附录 A PICkit 3 原理图——提供 PICkit 3 编程器 / 调试器的硬件原理图。

• 附录 B 操作建议——解决设计应用程序时要考虑的操作问题。
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本指南使用的约定

本文档采用下列约定：

文档约定

说明 涵义 示例

Arial 字体：

斜体字 参考书目 MPLAB® IDE User’s Guide

需强调的文字 ... 仅有的编译器 ...
首字母大写 窗口 Output 窗口

对话框 Settings 对话框

菜单选项 选择 Enable Programmer
引用 窗口或对话框中的字段名 “Save project before build”
带右尖括号前有下划线的斜体
文字

菜单路径 File>Save

粗体字 对话框按钮 单击 OK
选项卡 单击 Power 选项卡

尖括号 < > 括起的文字 键盘上的按键 按 <Enter> 和 <F1>
Courier New 字体：

常规 源代码示例 #define START

文件名 autoexec.bat

文件路径 c:\mcc18\h

关键字 _asm, _endasm, static

命令行选项 -Opa+, -Opa-

位值 0, 1

常数 0xFF,’A’

斜体 可变参数 file.o，其中 file可以是任
一有效文件名

方括号 [ ] 可选参数 mpasmwin [options] 
file [options]

花括号和竖线：{ | } 选择互斥参数；“或”选择 errorlevel {0|1}

省略号 ... 代替重复文字 var_name [, 
var_name...]

表示由用户提供的代码 void main (void)
{ ...
}
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保修登记

请填写随附的保修登记卡 （Warranty Registration Card）并尽快寄出。 寄出保修登记
卡的客户将可收到新产品更新信息。 临时发布的软件在 Microchip 网站上提供。

推荐读物

本用户指南介绍了如何使用 PICkit 3。 下面列出了其他有用的文档。 以下 Microchip 文
档均已提供，并建议读者作为补充参考材料。

44-Pin Demo Board User’s Guide （DS41296）
如需了解关于如何使用 44 引脚演示板作为开发工具在目标板上仿真和调试固件的指示
信息，请查阅此文档。

低引脚数演示板用户指南 （DS51556A_CN）

如需了解关于如何使用 Microchip Technology 的低引脚数器件 （8 引脚、 14 引脚和
20 引脚）的指示信息，请查阅此文档，其中包括一系列教程。

MPLAB® IDE 用户指南 / 帮助 （DS51519A_CN）

如需了解更多关于 MPLAB 集成开发环境 （Integrated Development Environment，
IDE）软件的安装和功能的信息，请查阅此文档。还提供了在线帮助版本。

In-Circuit Serial Programmer™ (ICSP™) Guide （DS30277）
本文档中的设计指南将帮助您成功进行 ICSP 编程，其中包括关于硬件设计的应用笔
记和 ICSP 编程规范。

MPASM™ 汇编器、 MPLINK™ 目标链接器、 MPLIB™ 目标库管理器用户指南
（DS33014J_CN）

说明了如何使用 Microchip PIC® MCU 汇编器 （MPASM 汇编器）、链接器 （MPLINK
链接器）和库管理器 （MPLIB 库管理器）。

PICkit™ 3 Debug Express 的自述文件

如需了解使用 PICkit 3 Debug Express 的最新信息，请阅读 MPLAB IDE 安装目录的
Readmes 子目录下的“Readme for PICkit 3.htm”文件（HTML 文件）。 该自述
文件包含了本用户指南中可能未包括的更新信息和已知问题。

PICkit™ 3 Debug Express C18 Lessons

这些教程将逐步指导用户如何结合使用 PICkit 3 Debug Express 和用于 PIC18 MCU 的
MPLAB C 编译器。在 MPLAB IDE CDROM 和 Microchip 网站上均有提供。

自述文件

如需关于使用其他工具的最新信息，请阅读 MPLAB IDE 安装目录的 Readmes 子目录
下的相应工具的自述文件。 这些自述文件包含了本用户指南中可能未包括的更新信息
和已知问题。
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MICROCHIP 网站

Microchip 网站 （www.microchip.com）为客户提供在线支持。 客户可通过该网站方便
地获取文件和信息。 只要使用常用的因特网浏览器即可访问，网站提供以下信息：

• 产品支持——数据手册和勘误表、应用笔记和示例程序、设计资源、用户指南以 
及硬件支持文档、最新的软件版本和存档软件

• 一般技术支持——常见问题解答 （FAQ）、技术支持请求、在线讨论组以及
Microchip 顾问计划成员列表

• Microchip 业务——产品选型和定购指南、最新 Microchip 新闻稿、研讨会与活动
安排表、 Microchip 销售办事处、代理商以及工厂代表列表

开发系统客户变更通知服务

Microchip 的客户通知服务有助于客户了解 Microchip 产品的最新信息。 注册客户可在
他们感兴趣的某个产品系列或开发工具发生变更、更新、发布新版本或勘误表时，收 
到电子邮件通知。

欲注册，请登录 Microchip 网站 www.microchip.com，点击 “ 变更通知客户”
（Customer Change Notification）服务并按照注册说明完成注册。

开发系统产品的分类如下：

• 编译器——Microchip C 编译器、汇编器、链接器及其他语言工具的最新信息。 包
括所有的 MPLAB C 编译器、所有的 MPLAB 汇编器 （包括 MPASM™ 汇编器）、
所有的 MPLAB 链接器 （包括 MPLINK™ 目标链接器）以及所有的 MPLAB 库管
理器 （包括 MPLIB™ 目标库管理器）。

• 仿真器——Microchip 在线仿真器的最新信息，包括 MPLAB REAL ICE™、
MPLAB ICE 2000 在线仿真器。

• 在线调试器——Microchip 在线调试器的最新信息，包括 MPLAB ICD 2、 ICD 3、
PICkit™ 2 和 PICkit™ 3。

• MPLAB® IDE——关于开发系统工具的 Windows® 集成开发环境 Microchip 
MPLAB IDE 的最新信息。 主要针对 MPLAB IDE、 MPLAB IDE 项目管理器、 
MPLAB 编辑器和 MPLAB SIM 软件模拟器以及一般的编辑和调试功能。

• 编程器——Microchip 编程器的最新信息，包括 MPLAB PM3 器件编程器和      
PICSTART® Plus 以及 PICkit 2 和 PICkit 3 开发编程器。

http://www.microchip.com
http://www.microchip.com
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客户支持

Microchip 产品的用户可以通过以下渠道获得帮助：

• 代理商或代表

• 当地销售办事处

• 应用工程师 （FAE）
• 技术支持

客户应联系其代理商、代表或应用工程师 （FAE）寻求支持。 当地销售办事处也可为
客户提供帮助。 本文档后附有销售办事处的联系方式。 销售办事处的完整最新列表请
参见我们的网站。

也可通过 http://support.microchip.com 网站获得技术支持。

http://support.microchip.com
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注：
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第 1 章  概述

1.1 简介

本章给出了 PICkit 3 编程器 / 调试器系统的概述。

• PICkit 3 编程器 / 调试器的定义

• PICkit 3 编程器 / 调试器提供的功能

• PICkit 3 编程器 / 调试器组件

• 支持的器件及功能

1.2 PICKIT 3 编程器 / 调试器的定义

PICkit 3 编程器 / 调试器 （见图 1-1）是一款由在 Windows® 平台上运行 MPLAB IDE
（v8.20 或更高版本）软件的 PC 控制的简单低成本在线调试器。 PICkit 3 编程器 / 调
试器是开发工程师工具包的不可或缺的组成部分。可用于从软件开发到硬件集成等各
种应用领域。

PICkit 3 编程器 / 调试器是一款支持硬件和软件开发的调试器系统，用于基于在线串行
编程 （In-Circuit Serial Programming™， ICSP™）和增强型在线串行编程双线串行接
口的 Microchip PIC® 单片机 （MCU）和 dsPIC® 数字信号控制器 （Digital Signal 
Controller， DSC）。 除了调试器功能以外， PICkit 3 编程器 / 调试器系统还可用作开发
编程器。

由于该调试器系统使用带有内置仿真电路的器件 （而非特殊调试器芯片）进行仿真， 
因此执行代码的方式与实际器件相似。用户可以交互地访问给定器件的所有可用功能，
且可通过 MPLAB IDE 界面设置和修改这些功能。

PICkit 3 调试器是为仿真具有调试功能的嵌入式处理器而开发的。 PICkit 3 的功能包
括：

• 使用 Windows 标准驱动程序的全速 USB 支持

• 实时执行

• 处理器以最大速度运行

• 内置的过压 / 短路监视器

• 小于等于 5V 的低压 （范围为 1.8-5V）
• 诊断 LED （电源、活动和状态）

• 可读写单片机的程序存储器和数据存储器

• 可擦除所有存储器类型 （EEPROM、 ID、配置和程序）并带有校验功能

• 断点处冻结外设

注： PICkit 3 旨在用于开发编程。对于生产编程，请考虑使用 MPLAB PM3 器
件编程器或其他为生产环境而设计的第三方编程器。



PICkit™ 3 用户指南

DS51795A_CN 第 10 页  2009 Microchip Technology Inc.

图 1-1： PICkit™ 3 MCU 编程器 / 调试器

1.2.1 挂绳连接

编程器上提供了一个方便的挂绳连接。

1.2.2 USB 端口连接

USB 端口连接是 USB 微型 B 连接器。请使用随付的 USB 电缆将 PICkit 3 连接到 PC。

1.2.3 引脚 1 标记

此标记指示引脚 1 的位置以确保连接器正确对齐。

1.2.4 编程连接器

编程连接器是用于连接到目标器件的 6 引脚连接头 （间距 0.100"）。 引脚排列规范，
请参见图 1-2。 

6

21

3

4

图注：

1 – 挂绳连接

2 – USB 端口连接

3 – 引脚 1 标记

4 – 编程连接器

5 – 状态 LED
6 – 按钮 （将来使用）

5
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图 1-2： PICKIT™ 3 编程器连接器引脚排列

1.2.5 状态 LED
状态 LED 指示 PICkit 3 的状态。

1. 电源 （绿色）——PICkit 3 已通过 USB 端口上电。

2. 活动 （蓝色）——PICkit 3 已连接到 PC USB 端口且通信链路是活动的。

3. 状态：

忙 （黄色）——PICkit 3 正忙于处理某个功能，例如编程。

错误 （红色）——PICkit 3 遇到错误。

1.3 PICKIT 3 编程器 / 调试器提供的功能

PICkit 3 编程器 / 调试器允许您：

• 在自己的硬件上实时调试应用程序

• 使用硬件断点调试

• 基于内部事件设置断点

• 监视内部文件寄存器

• 全速仿真

• 编程器件

1
2
3
4
5
6

* 6 引脚连接头 （0.100" 间距）可连接 0.025" 的方形引脚。

引脚说明 *
1 = VPP/MCLR
2 = 目标器件的 VDD

3 = VSS （地）

4 = ICSPDAT/PGD
5 = ICSPCLK/PGC
6 = LVP

引脚 1 指示

注： 在编程串行 EEPROM 器件和 HCS 器件时编程连接器引脚功能有些不同。 
这些引脚排列请参见随 MPLAB IDE 软件一起提供的 PICkit 3 自述文件
（Help>Readme （帮助 > 自述文件））。
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1.4 PICKIT 3 编程器 / 调试器组件

PICkit 3 编程器 / 调试器系统的组件有：

1. 带有电源、活动和状态指示灯的 PICkit 3。
2. 提供调试器和 PC 之间的通信并为调试器供电的 USB 电缆。

3. 附有 MPLAB IDE 软件和在线文档的光盘。

图 1-3： 基本调试器系统

需要单独订购的其他硬件：

• 包括以下内容的 PICkit 3 Debug Express 工具包：

- 带 PIC18F45K20 MCU 的 44 引脚演示板

- 用于 PIC18 MCU 的免费版 MPLAB C 编译器

- 浅显易懂的课程和教程

- 其他软件实用程序、源代码示例和完整文档

• 转换插座

• ICD 仿真头

• MPLAB IDE 处理器扩展工具包

PICkit™ 3

到目标板

连接到 PC 的

指示灯

USB 电缆
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1.5 支持的器件及功能

表 1-1 和表 1-2 给出了支持的器件及器件功能。

表 1-1： 16 位 （数据存储器）器件

功能
 dsPIC33F 和

PIC24F/H
dsPIC30F 
SMPS(1) dsPIC30F

复位应用程序 C C C
运行和暂停 C C C
单步执行 C C C
连续单步执行 C C C
全速仿真 C C C
硬件断点 C C C
外设冻结 (2) C C C
在取数据操作或写操作时中断 C C C
堆栈溢出时中断 N N N
跑表 C C N
次数计数器 C C C
WDT 溢出 C C N
标准通信速度 C C C
处理器套件 F F N
图注：

C = 当前支持
D = 支持取决于器件
F = 现在不支持，但计划将来支持
N = 不提供支持

注   1： 当前的开关电源（Switch Mode Power Supply， SMPS）器件：dsPIC30F1010/2020/2023。
2：根据所选择的器件，此功能的工作方式有所不同。
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表 1-2： 8 位 （数据存储器）器件

功能 PIC18FXXJ
PIC18F、

PIC18F Enh 和
PIC18FXXK

PIC12F 和
PIC16F

复位应用程序 C C C
运行和暂停 C C C
单步执行 C C C
连续单步执行 C C C
全速仿真 C C C
硬件断点 C C C
外设冻结 (1) C C C
在取数据操作或写操作时中断 C C N
堆栈溢出时中断 C C N
跑表 C N N
次数计数器 C C N
WDT 溢出 C N N
标准通信速度 C C C
处理器套件 F F F
图注：

C = 当前支持
F = 现在不支持，但计划将来支持
N = 不提供支持

注 1： 根据所选择的器件，此功能的工作方式有所不同。
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第 2 章  工作原理

2.1 简介

本章简要描述了 PICkit 3 编程器 / 调试器系统的工作原理。旨在提供足够的信息来帮助
用户设计出与该调试器兼容的目标板，以进行仿真和编程操作。还描述了在线仿真和
编程的基本原理，以便用户能够快速地解决遇到的问题。

• PICkit 3 与 PICkit 2 的对比

• 调试器与目标板之间的通信

• 通信连接

• 调试

• 调试要求

• 编程

• 调试器使用的资源

2.2 PICkit 3 与 PICkit 2 的对比

PICkit 3 编程器 / 调试器系统在功能上与 PICkit 2 编程器 / 调试器系统相似。 这两个调
试器的相似点包括：

• 通过连接到 PC 的 USB 电缆供电

• 提供可编程的电压源

PICkit 3 与 PICkit 2 的不同之处在于：

• 扩展的 EE 程序映像空间 （512 KB）
• 真正的参考电压

• 扩大的电压范围 （1.8-5V VDD ； 1.8-14V VPP）

2.3 调试器与目标板之间的通信

接下来的章节将讨论调试器系统配置。

标准 ICSP 器件通信

可将调试器系统配置为使用标准 ICSP 通信执行编程和调试功能。 6 引脚连接方式与
PICkit 2 编程器 / 调试器使用的连接方式相同。

警告

不要在 PICkit 3 或目标板上电时更改硬件连接。
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模块化电缆可以 (1) 插入到目标板上与之匹配的插座中，其中目标器件在目标板上
（图 2-1）；或者 (2) 插入到标准适配器／仿真头板组合 （作为处理器套件），然后插
入到目标板中 （图 2-2）。

更多关于标准通信的信息，请参见第 10 章 “硬件规范”。

图 2-1： 标准调试器系统——内置 ICE 电路的器件

图 2-2： 标准调试器系统——ICE 器件

注： 以前的仿真头板使用 6 引脚 （RJ-11）连接器，而非 8 引脚连接器，所以
这些仿真头可以通过 AC164110 ICSP 适配器连接到调试器。

目标器件

或 PIM

电源

PICkit™ 3

连接到 PC 的
微型 USB 电缆

目标板

目标板转换插座

器件 -ICE

AC164110
适配器

仿真头

电源

PICkit™ 3

连接到 PC 的
微型 USB 电缆
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2.4 通信连接

2.4.1 通信目标板连接

2.4.1.1 使用单列直插式连接器

PICkit 3 编程器 / 调试器使用 6 引脚直插式连接器连接到目标板连接器。 请参见图 2-1
以及表 2-1 和第 10.6 节 “标准通信硬件”。

2.4.1.2 使用适配器

PICkit 3 编程器 / 调试器使用 AC164110 适配器通过模块化接口 （6 芯）电缆连接到目
标器件。连接器的引脚编号显示在目标 PCB 的底部，如图 2-3 所示。 

图 2-3： 目标板上的标准 RJ-11 连接

2.4.2 目标板连接电路

图 2-4 显示了 PICkit 3 编程器 / 调试器与目标板上连接器的互连情况。该图还显示了从
连接器到目标 PCB 上器件的连线。建议在 VPP/MCLR 线和 VDD 之间接一个上拉电阻
（通常约为 10 kΩ 左右），这样可将 VPP/MCLR 线置为低电平来复位器件。

表 2-1： 目标连接器引脚排列

连接器引脚 单片机引脚

1 MCLR/VPP

2 VDD

3 地

4 PDG （ICSPDAT）
5 PGC （ICSPCLK）
6 LVP

注： 调试器和目标板上的电缆连接互为镜像，即电缆一端上的引脚 1 连接到电
缆另一端的引脚 6， 请参见第 10.6.2.3 节 “模块化电缆规范”。

1

2

3

4

5

6

目标
连接器

目标

底部
PCBVPP/MCLR

Vss

PGC
VDD

PGD
LVP
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图 2-4： 标准连接目标电路

2.4.3 目标板供电

在下面的说明中，将只谈到与关键调试器操作相关而且有效的三根线： 引脚 1
（VPP/MCLR）、引脚 5 （PGC）和引脚 4 （PGD）。 引脚 2 （VDD）和引脚 3
（VSS）显示在图 2-4 中是出于完整性考虑。 PICkit 3 为给目标器件供电提供了两种配
置：内部调试器和外部目标电源。

推荐使用来源于目标应用的外部电源。在此配置中，目标 VDD 由调试器检测，以允许
进行电平转换使之适用于目标低电压操作。如果调试器在其 VDD 线 （接口连接器的引
脚 2）上检测不到电压，它将不能工作。

2.4.4 调试器供电

内部调试器电源电流限制为 30 mA。这对于那些为独立编程而将器件 VDD 与应用电路
的其余部分隔离开的小型应用很有用，但是不推荐普遍使用，因为它对源自 PC 的
USB 供电系统有更高的电流要求。

不是所有的器件都有 AVDD 和 AVSS 线，但是如果目标器件上有这两根线，为了调试器
能够正常工作，必须将它们连接到合适的电平。它们不能处于悬空状态。

通常情况下，推荐将所有的 VDD/AVDD 和 VSS/AVSS 线连接到合适的电平。而且，带
有 VCAP 线的器件 （例如 PIC18FXXJ）也应该连接到合适的电容或电平。

VDD

VPP/MCLR
PGC
PGD
VSSAVDD

AVSS

2

1
5
4
3

用户复位

4.7K -10K

接口
连接器

应用
PCB

器件

注： PICkit 3 编程器 / 调试器与目标板的互连非常简单。出现的所有问题往往是
由这几根关键线上的其他连接或元器件影响 PICkit 3 编程器 / 调试器的运
行引起的，下一节将对此进行讨论。
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2.4.5 影响调试器正常运行的电路

图 2-5 中显示了在调试器的有效线上连接某些元器件会影响 PICkit 3 调试器系统正常
运行。

图 2-5： 不正确的电路元器件

确切地说，必须遵循以下准则：

• PGC/PGD 不要接上拉电阻——由于在调试器中这些线上有 4.7 kΩ 的下拉电阻，
上拉会破坏电压值。

• PGC/PGD 不要接电容——在编程和调试通信期间，它们会阻止数据线和时钟线上
电平的快速转换。

• MCLR 不要接电容——它们会阻止 VPP 上电平的快速转换。通常一个简单的上拉
电阻就足够了。

• PGC/PGD 不要接二极管——它们会阻止调试器和目标器件之间的双向通信。

2.5 调试

使用 PICkit 3 编程器 / 调试器系统作为调试器有两个步骤。 第一步要求将应用程序烧写
到目标器件中 （通常使用 PICkit 3 本身）。 第二步使用目标闪存器件内部的在线调试
硬件来运行和测试应用程序。 这两步与 MPLAB IDE 的操作直接相关：

1. 烧写代码到目标器件并激活具体的调试功能 （详细信息请参见下一节）。

2. 使用调试器设置断点并运行。

如果目标器件不能被正确编程，那么 PICkit 3 编程器 / 调试器将无法进行调试。

图 2-6 显示了编程所要求的基本电路互连。 注意这个图与图 2-4 相同，但是为了更简
洁，没有显示来自调试器的 VDD 和 VSS 线。

不允许！

不允许！

不允许！
VPP/MCLR

PGC

PGD

1

5

4

接口
连接器

不允许！
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图 2-6： 编程要求的正确电路连接

上图显示了 PICkit 3 编程器 / 调试器部分内部接口电路的简化电路图。 编程时，目标器
件不需要时钟，但必须为其提供电源。 编程时，调试器在 VPP/MCLR 上施加编程电
压，通过 PGC 发送时钟脉冲并通过 PGD 发送串行数据。 要校验器件是否已被正确编
程，可以向 PGC 发送时钟，并通过 PGD 读回数据，这符合开发阶段所使用器件的
ICSP 协议。

2.6 调试要求

要使用 PICkit 3 编程器 / 调试器系统进行调试 （设置断点和查看寄存器等），以下几个
关键因素必须正确：

• 调试器必须与 PC 相连。 必须由 PC 通过 USB 电缆对其供电，还必须通过 USB 电
缆与 MPLAB IDE 软件通信。 详细信息请参见第 3 章 “安装”。

• 调试器必须按照图中所示，通过模块化接口电缆 （或类似电缆）连接到目标器件
的 VPP、 PGC 和 PGD 引脚。调试器和目标器件之间的 VSS 和 VDD 也需要连接起
来。

• 目标器件必须有电源和正常运行的振荡器。无论是什么原因使目标器件不工作，
PICkit 3 编程器 / 调试器都不能进行调试。

• 必须对目标器件的配置字进行正确编程：

- 振荡器配置位应与 RC 和 XT 等相对应，具体取决于目标板的设计。

- 某些器件的看门狗定时器默认情况下是使能的，需要禁止。

- 不要使能目标器件的代码保护功能。

- 不要使能目标器件的表读保护功能。

• 应禁止 LVP 功能。

满足了以上条件后，即可接着进行下列操作：

• 进入调试模式的操作顺序

• 调试模式细节

+5V

编程

4.7 kΩ

4.7 kΩ

VPP/MCLR

PGC

PGD

1

5

4

内部电路

VSS

VDD
电压
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2.6.1 进入调试模式的操作顺序

如果满足了调试要求 （见上一节），那么在从 MPLAB IDE 菜单把 PICkit 3 编程器 / 调
试器设置为当前调试器 （Debugger>Select Tool>PICkit 3 （调试器 > 选择工具
>PICkit 3））时，可以执行以下操作：

• 通过选择 Project>Build Configuration>Debug （项目 > 编译配置 > 调试）来编译 /
汇编应用程序代码。

• 当选择 Debugger>Program （调试器 > 编程）时，应用程序代码就会通过上述的
ICSP 协议烧写到器件的存储器中。

• 一个小的 “调试执行程序”被 MPLAB IDE 自动载入到目标器件的程序存储器的
高地址段。由于调试执行程序必须驻留在程序存储器中，因此应用程序不能使用这
段保留的空间。有些器件为调试执行程序提供了专门的存储区。详细信息请参考器
件数据手册。

• 使能目标器件中的特殊 “在线调试”寄存器。 这使得调试执行程序能被调试器激
活。

• 通过保持 VPP/MCLR 线为低电平，保持目标器件处于复位状态。

2.6.2 调试模式细节

图 2-7 显示了准备好调试的 PICkit 3 编程器 / 调试器系统。

图 2-7： 准备好调试的 PICkit™ 3 调试器

一般来说，为判断应用程序能否正确运行，可在程序代码中预先设置断点。当通过
MPLAB IDE 的用户界面设置断点时，断点的地址保存在目标器件的特殊内部调试寄存
器中。 PGC 和 PGD 上的命令直接传送到这些寄存器来设置断点地址。

接着，在 MPLAB IDE 中选择 Debugger>Run （调试器 > 运行），或通过通常的做法
单击 Run 图标 （前向箭头）。 然后，调试器通知调试执行程序运行。目标器件将从复
位向量开始执行，直到程序计数器到达先前存储在内部调试寄存器中的断点地址为止。

执行了断点地址处的指令之后，目标器件的在线调试机制就会启动，并将器件的程序 
计数器值传递给调试执行程序 （很像中断），同时用户的应用程序也暂停执行。 调试

+5V
+12V

4.7 kΩ

4.7 kΩ

内部电路

程序
存储器

文件
寄存器

内部
调试

寄存器

VPP/MCLR

PGC

PGD

1

5

4

执行程序
调试

调试执行程序

目标器件

才能使
调试执行

必须运行

为调试执行

VDD

由调试执行程序
共用的硬件堆栈

使用的空间

程序保留的
空间

 

程序正常
运行
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器通过 PGC 和 PGD 与调试执行程序通信，获取断点状态信息，并将这些信息传送回
MPLAB IDE。MPLAB IDE 接着向调试器发送一系列查询以获取关于目标器件的信息，
如文件寄存器的内容和 CPU 的状态。这些查询最终由调试执行程序来执行。

调试执行程序像程序存储器中的应用程序一样运行。它使用堆栈中的某些地址单元存
储临时变量。如果器件不工作——不管什么原因 （如没有振荡器、电源连接故障及 目
标板短路等），则调试执行程序将无法与 PICkit 3 编程器 / 调试器通信，并且 MPLAB 
IDE 会发出一条错误消息。

另一种获取断点的方法是按下 MPLAB IDE 中的 Halt （暂停）按钮 （Run 箭头右边的
“暂停”符号）。这将翻转 PGC 和 PGD 线，从而使目标器件的在线调试机制将程序
计数器从程序存储器中的用户代码切换到调试执行程序。目标应用程序暂停，MPLAB 
IDE 通过调试器与调试执行程序的通信来查询目标器件的状态。

2.7 编程

可使用 PICkit 3 编程器 / 调试器作为编程器来对实际 （非 ICE/ICD）器件 （即仿真头
板外的器件）编程。 从 Programmer>Select Programmer （编程器 > 选择编程器）中
选择 “PICkit 3”，并将 MPLAB IDE 工具栏上的 “Build Configuration”（编译配置）
列表框设置为 “Release”（发布）来编译 / 汇编应用程序代码。也可以通过选择
Project>Build Configuration>Release （项目 > 编译配置 > 发布）进行设置。

当调试器用作编程器时，所有调试功能都被关闭或移除。当使用
Programmer>Program （编程器 > 编程）选择对器件进行编程时，应该在 MPLAB 
IDE 中禁止在线调试寄存器，这样 PICkit 3 编程器 / 调试器将只烧写目标应用程序代码
和配置位 （以及 EEPROM 数据，如果有并选中的话）到目标器件中。 调试执行程序
不会被加载。 作为编程器，该调试器只能通过翻转 MCLR 线来复位和启动目标器件。 
不能设置断点，也不能查看或改变寄存器的内容。

PICkit 3 编程器 / 调试器系统使用 ICSP 对目标器件进行编程。 VPP、 PGC 和 PGD 线
应该按照之前的描述进行连接。编程时不需要时钟，并且处理器的所有模式都能被编
程，包括代码保护、看门狗定时器以及表读保护。

2.8 调试器使用的资源

如需器件中调试器所用资源的完整列表，请参见 MPLAB IDE 中 PICkit 3 编程器 / 调试
器的在线帮助文件。
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第 3 章  安装

3.1 简介

本章讨论了如何安装 PICkit 3 编程器 / 调试器系统。

• 安装软件

• 连接到目标板

• 设置目标板

• 设置 MPLAB IDE

3.2 安装软件

要安装 MPLAB IDE 软件，首先从 Microchip 网站 （www.microchip.com）上或 
MPLAB IDE 光盘 （DS51123）中获取最新版本的 MPLAB IDE 安装可执行程序 
（MPxxxxx.exe，其中 xxxxx代表 MPLAB IDE 的版本）。然后运行该可执行程序并
按照屏幕指示来安装 MPLAB IDE。

3.3 连接到目标板

内置的连接允许选择与目标板的通信类型。 请参见第 2.3 节 “调试器与目标板之间的
通信”以了解更多详细信息和连接图。

1. 如果还未连接，请插入 USB/ 电源电缆。

2. 在调试器和目标板之间连接通信电缆 （使用 RJ-11 连接器）或直接连接到 6 引
脚直插式连接器。

图 3-1： 插入通信电缆和 USB/ 电源电缆

注： 要使用 PICkit 3 编程器 / 调试器，需要 MPLAB IDE v8.20 或更高版本。

PICkit™ 3

连接到目标板连接到 PC 的
或仿真头

21

USB 电缆



PICkit™ 3 用户指南

DS51795A_CN 第 24 页  2009 Microchip Technology Inc.

3.4 设置目标板

3.4.1 使用生产器件

对于生产器件，调试器可直接与目标板相连。目标板上的器件必须有内置调试电路，
以便 PICkit 3 编程器 / 调试器能够使用它进行仿真操作。 请查阅相应的器件数据手册，
以查看该器件是否具有所需的调试电路，即应具有一个 “Background Debugger 
Enable”（后台调试器使能）配置位。

目标板必须有一个连接器，以适合为调试器所选的通信方式。如需了解连接信息，请
参见第 2.3 节 “调试器与目标板之间的通信”中的 “标准 ICSP 器件通信”。

3.4.2 使用 ICE 器件

对于 ICE 器件，需要 ICE 仿真头板。仿真头板包含仿真特定器件或器件系列所必需的
硬件。更多关于 ICE 仿真头的信息，请参见 “Header Board Specification”
（DS51292）。

将转换插座与 ICE 仿真头一起使用，以将仿真头连接到目标板。提供了多种类型的转
换插座，以允许通用的仿真头能够与某个受支持的表面贴装类型相连。更多关于转换
插座的信息，请参见 “Transition Socket Specification”（DS51194）。

仿真头或处理器扩展套件的仿真头板布线有所不同。如需了解连接信息，请参见第 2.3
节 “调试器与目标板之间的通信”中的 “标准 ICSP 器件通信”。

3.4.3 使用 ICD 仿真头

所有低档 PIC 单片机和一些中档 PIC 单片机都需要在调试仿真头电路板上贴装一个特
殊 ICD 器件以使能调试功能。如需这些器件的列表以及所需 ICD 仿真头板的部件编
号，请参见 “Header Board Specification”（DS51292）。 仿真头板规范包含在
PICkit 3 光盘中，在 www.microchip.com 上也有在线提供。

每个 ICD 仿真头板都附有必需的 ICD 器件，可用于目标板而非生产单片机。 但是，大
多数仿真头板的 RJ-11 调试连接器需要使用 AC164110 RJ-11 至 ICSP 适配器工具包
连接到 PICkit 3。图 3-2 显示了如何配合使用用于 PIC18F45K20 的 AC162061 ICD 仿
真头和 AC164110 适配器工具包以及低引脚数演示板。

注： 将来，可使用具有支持 ICD 的电路的器件。

注： 将来，可使用具有 ICD 器件 （器件 -ICD）的 ICD 仿真头板。
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图 3-2： 使用 ICD 仿真头板

许多中档 PIC 单片机以及所有 PIC18 和 16 位 PIC 单片机器件不需要 ICD 仿真头，可
直接通过 ICSP 编程连接进行调试。

3.4.4 为目标板供电

以下为配置要点：

• 当使用 USB 连接时， PICkit 3 可由 PC 供电，但它只能够在 1.8-5V 的 VDD 下为较
小的目标板提供最大 30 mA 的有限大小电流。

• 理想的方法是由目标板提供 VDD，因为它可提供更高的电流。它的另一个优点是
可继承即插即用的目标检测功能，即当它检测到目标板和器件时， MPLAB IDE 会
在 Output （输出）窗口中通知您。

请使用合适的电缆将 PICkit 3 连接到目标板，如果还没有这样做的话 （见第 3.3 节
“连接到目标板”）。 然后为目标板供电。 如果您通过 PICkit 3 为目标板供电，请遵循
第 9.5.8 节 “Settings 对话框， Power （电源）选项卡”中的指示。 

3.5 设置 MPLAB IDE
连接了硬件并上电后，便可设置 MPLAB IDE，以使用 PICkit 3 编程器 / 调试器。

对于某些器件，您必须使用配置位选择通信通道 （例如 PGC1/EMUC1 和
PGD1/EMUD1）。 请确保此处选择的引脚与物理连接到器件的引脚相同。

更多关于 PICkit 3 项目设置和入门的信息，请参见第 4 章 “常规设置”。 

注： 目标电压只用于为 ICSP 接口的驱动电路供电；而不能为 PICkit 3 供电。
PICkit 3 电源来自于 USB 端口。



PICkit™ 3 用户指南

DS51795A_CN 第 26 页  2009 Microchip Technology Inc.

注：



PICkit™ 3 用户指南

 2009 Microchip Technology Inc. DS51795A_CN 第27 页

第 4 章  常规设置

4.1 简介

本章讨论了如何开始使用 PICkit 3 编程器 / 调试器。

• 启动 MPLAB IDE 软件

• 创建项目

• 查看项目

• 编译项目

• 设置配置位

• 将编程器 / 调试器设置为调试器或编程器

• 调试器／编程器限制

4.2 启动 MPLAB IDE 软件

安装完 MPLAB IDE 软件 （第 3.2 节 “安装软件”）后，用如下任一种方法启动该软
件：

• 选择开始 > 所有程序 >Microchip>MPLAB IDE vx.xx>MPLAB IDE，其中 vx.xx 为
版本号。

• 双击桌面上的 MPLAB IDE 图标。

• 执行在 MPLAB IDE 安装目录中 mplab ide\core子目录下的 mplab.exe文
件。

如需获取更多有关该软件使用方面的信息，请参阅：

• 《MPLAB IDE 用户指南》（DS51519A_CN）——使用 MPLAB IDE 的综合性指
南。

• 在线帮助文件——包含 MPLAB IDE 和 PICkit 3 编程器 / 调试器的最新信息。

• 自述文件——每次发布的最新信息都包含在 Readme for MPLAB IDE.txt和
Readme for PICkit 3 Debugger.txt中。 这两个文件都位于 MPLAB IDE 安
装目录的 Readmes子目录中。

4.3 创建项目

创建新项目最简单的方法是选择 Project>Project Wizard （项目 > 项目向导）。 在
Project Wizard （项目向导）的帮助下，可创建新项目和选择用于编译该项目的语言工
具。该向导将指导您完成在项目窗口中的不同 “节点”上添加源文件和库文件等的过
程。 请参阅 MPLAB IDE 文档获取使用此向导的详细信息。 此处提供的基本步骤有：

• 选择器件 （例如 PIC18F45K20）
• 选择语言工具包 （例如 Microchip C 编译器工具包）

• 命名项目

• 添加应用程序文件 （例如， program.c、 support.s和 counter.asm）

注： 如果项目中没有自定义链接描述文件，项目管理器将为您选择合适的链接
描述文件。
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4.4 查看项目

在使用 Project Wizard 创建了项目之后，在项目窗口中可看到该项目及其相关文件。 
右击项目窗口树中的任一行以弹出一个带有添加和移除文件的附加选项的菜单。

请参阅 MPLAB IDE 文档获取使用此项目窗口的详细信息。

4.5 编译项目

创建项目后，需要编译应用程序。这将为应用程序生成目标 （Hex）代码，可通过
PICkit 3 编程器 / 调试器将目标代码烧写到目标器件中。

要设置编译选项，选择 Project>Build Options>Project （项目 > 编译选项 > 项目）。

完成时，选择 Project>Build All （项目 > 编译全部）来编译项目。

4.6 设置配置位

器件配置位可在代码中设置，也可在 MPLAB IDE 配置窗口中设置。 选择
Configure>Configuration Bits （配置 > 配置位）。 通过点击 “Settings”（设置）栏中
的文本，可以修改这些配置位。

一些相关的配置位有：

• Watchdog Timer Enable （看门狗定时器使能）—— 在大多数器件上，看门狗定
时器初始情况下是使能的。 禁止该位通常是一个很好的做法。

• Comm Channel Select （通信通道选择）——对于有些器件，您需要为器件选择 
通信通道，例如 PGC1/EMUC1 和 PGD1/EMUD1。 请确保此处选择的引脚与物理
连接到器件的引脚相同。

• Oscillator （振荡器）——选择与目标振荡器匹配的配置设置。

4.7 将编程器 / 调试器设置为调试器或编程器

选择 Debugger>Select Tool>PICkit 3 来选择 PICkit 3 编程器 / 调试器作为调试工具。 
一旦选择了这个工具， Debugger 菜单和 MPLAB IDE 工具栏会有相应的变化以显示调
试选项。同时，将会打开 Output （输出）窗口，且 PICkit 3 选项卡上将会显示关于
PICkit 3 状态和通信的消息。更多信息，请参见第 9.2 节 “调试功能”和第 9.3 节
“调试对话框／窗口”。

选择 Programmer>Select Programmer>PICkit 3 来选择 PICkit 3 编程器 / 调试器作为
编程器工具。 一旦选择了这个工具， Programmer （编程器）菜单和 MPLAB IDE 工具
栏会有相应的变化以显示编程器选项。同时，将会打开 Output 窗口，且 PICkit 3 选项
卡上将会显示关于 PICkit 3 状态和通信的消息。 更多信息，请参见第 9.4 节 “编程功
能”。

选择 Debugger>Settings （调试器 > 设置）或 Programmer>Settings （编程器 > 设 
置）以打开 Settings 对话框 （第 9.5 节 “Settings 对话框”）并根据需要设置选项。

如果发生错误，请参见：

• 第 8 章 “错误消息”

• 第 7 章 “常见问题解答 （FAQ）”

注： 在 Project Manager （项目管理器）工具栏 （View>Toolbars>Project 
Manager （查看 > 工具栏 > 项目管理器））上，从下拉列表中选择 
“Debug”（当 PICkit 3 用作调试器时），或选择 “Release”（当 PICkit 3
用作编程器时）。
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4.8 调试器／编程器限制

如需器件的调试器限制的完整列表，请参见 MPLAB IDE 中的 PICkit 3 在线帮助文件，
可通过以下方法打开此文件：选择 Help>Topics>PICkit 3 （帮助 > 主题 >PICkit 3）并
单击 OK （确定）。
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第 5 章  PICkit 3 Debug Express

5.1 简介

PICkit 3 Debug Express 工具包与 MPLAB IDE 应用程序配合使用来运行、停止和单步
执行程序。可设置一个或多个断点，也可以复位处理器。 处理器停止后，可检查和修
改寄存器的内容。

更多关于如何使用 MPLAB IDE 的信息，请参阅以下文档：

• MPLAB® IDE 用户指南 （DS51519A_CN）

• MPLAB® IDE 在线帮助

5.2 PICkit 3 DEBUG EXPRESS 工具包内容

PICkit 3 Debug Express 工具包 （DV164131）包含以下各项：

1. PICkit 3 开发编程器 / 调试器

2. USB 电缆

3. 带器件的 44 引脚演示板 *
4. MPLAB IDE 光盘

5. 光盘上的 PICkit 3 Debug Express C18 课程 （教程）

* Explorer 16 开发板也可用于进行调试。

5.3 安装硬件和软件

请按照第 3 章 “安装”中指定的步骤安装 PICkit 3 硬件和软件 （如果还没有安装的
话）。

5.3.1 保留的资源

由于 ICD 器件的内置在线调试功能以及调试器提供的 ICSP 功能， PICkit 3 Debug 
Express 在调试时会使用部分片上资源。 
关于在线调试所需的器件资源的信息，请参阅在 MPLAB IDE 中的 Help>Topics 下找到
的 MPLAB PICkit 3 Help （MPLAB PICkit 3 帮助）。“Resoures Used By MPLAB 
PICkit 3”（MPLAB PICkit 3 使用的资源）下找到的器件保留资源信息也同样适用于
PICkit 3 Debug Express。

5.3.2 连接到演示板

只要按照图 5-1 所示的方法连接 44 引脚演示板和 PICkit 3 就可以对该演示板上的
PIC18F45K20 进行调试。

注： PICkit 3 Debug Express 需要 MPLAB IDE v8.20 或更高版本。
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图 5-1： 连接演示板和 PICkit™ 3

5.3.3 配置位和 Debug Express
无需 ICD 仿真头就可以直接调试的 PIC 单片机器件在配置字中包含 DEBUG 位，该位
可使能和禁止 PIC 单片机的调试模式。

使用 PICkit 3 Debug Express 时，MPLAB IDE 会自动对此位进行相应设置，不应在源
代码配置设置中指定该位。

许多 16 位 PIC 单片机器件 （例如 PIC24 和 dsPIC33 系列）具有多个 ICSP 编程和调
试端口引脚 （标记为 PGC1/EMUC1 和 PGD1/EMUD1、 PGC2/EMUC2 和
PGD2/EMUD2 等）。任何 ICSP 端口都可用于编程，而同一时刻只有一个端口可用于
调试。可在器件配置位中设置激活的 EMU 端口。 如果设置的激活端口与 PICkit 3 连接
的 EMU 端口不匹配，那么器件将无法进入调试模式。 在 MPLAB IDE Configuration 
Bits （配置位）对话框中，这些位通常称为 “Comm Channel Select”位。

警告

在正常情况下，不应在源代码配置设置中指定 DEBUG 配置位的值。 如果指定了 DEBUG 配置

位的值，会导致在脱离调试器对器件进行编程时该位为有效，从而导致器件在应用电路中无法
正常工作或根本不工作。
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第 6 章  故障诊断第一步

6.1 简介

如果 PICkit 3 编程器 / 调试器在工作过程中出现问题，请从此处开始故障诊断。

• 需最先回答的 5 个问题

• 不能调试的头 10 个原因

• 要考虑的其他事项

6.2 需最先回答的 5 个问题

1. 使用的是何种器件？ 要支持新的器件，通常要求将 MPLAB IDE 升级到较新的版
本。也就是说，黄灯 = 未经测试的支持。

2. 您使用的是 Microchip 的演示板还是您自己设计的电路板？ 您是否遵守了通信连
接的电阻 / 电容的连接准则？ 请参见第 2 章 “工作原理”。

3. 您是否已为目标板供电？ 调试器无法为目标板提供大于 30 mA 的电流。

4. 在安装过程中您是否使用了 USB 集线器？ 它是否已上电？ 如果仍有问题，请尝
试不使用集线器来连接调试器和 PC，而是将调试器直接插入 PC。

5. 您是否使用了随调试器一起提供的标准通信电缆（RJ-11）？ 如果您使用了更长
的电缆，则会导致通信错误。

6.3 不能调试的头 10 个原因

1. 振荡器不工作。检查与振荡器有关的配置位设置。

2. 目标板未上电。检查电源电缆连接。

3. 调试器已断开与 PC 和／或目标板的物理连接。检查通信电缆的连接。

4. 器件受到代码保护。检查与代码保护有关的配置位设置。

5. 您正在尝试在 Release （发布）模式下重新编译项目。在项目工具栏的 Build 
Configuration 下拉列表中选择 Debug，然后重新编译项目。

6. 在 MPLAB IDE 中，调试器选择作为编程器而非调试器。

7. 调试器与 PC 的通信已中断。在 MPLAB IDE 中重新连接到调试器。

8. 目标应用程序已损坏或包含错误。请尝试重新编译和重新编程目标应用程序。然
后启动目标器件的上电复位。

9. 其他配置设置影响调试操作。任何会阻止目标器件执行代码的配置设置也会阻止
调试器将代码置于调试模式。

10. 调试器无法总是执行所请求的操作。例如，如果目标应用程序目前正在运行，则
调试器无法设置断点。
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6.4 要考虑的其他事项

1.  错误也许是个一次性问题。再次尝试操作。

2. 通常情况下，可能是编程问题。我们来进行一个实验，切换到编程器模式并使用
最简单的应用程序 （例如用来点亮 LED 的程序）来对目标器件进行编程。如果
程序未运行，那么就可以知道是目标设置出了问题。

3. 有可能目标器件因某种原因受损 （例如过电流）。开发环境难以与器件兼容。请
考虑尝试其他目标器件。

4. Microchip Technology Inc. 提供了许多演示板来支持其大多数单片机。考虑使用
这些已知正常工作的应用中的一个来检查 PICkit 3 编程器 / 调试器的功能是否正
确。 

5. 查看调试器的调试操作以确保应用设置正确 （第 2 章 “工作原理”）。

6. 如果问题仍然存在，请联系 Microchip。
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第 7 章  常见问题解答（FAQ）

7.1 简介

欲知关于 PICkit 3 编程器 / 调试器系统常见问题的答案，请阅读本章。

• 如何工作

• 出现的问题

7.2 如何工作

• 芯片中的什么部件允许它与 PICkit 3 编程器 / 调试器通信？

PICkit 3 编程器 / 调试器可通过 ICSP 接口与闪存芯片通信。它使用下载到程序存
储器或测试存储区中的调试执行程序。

• 必须运行调试执行程序会如何影响处理器的吞吐量？

运行模式下，调试执行程序并不运行，所以在运行代码时不会降低吞吐量，即调试
器不会 “占用”目标器件的任何周期。

• PICkit 3 编程器 / 调试器与其他在线仿真器 / 调试器相比有何区别？

请参阅第 2.2 节 “PICkit 3 与 PICkit 2 的对比”。

• 在 MPLAB ICE 2000/4000 调试器中，为了对数据执行复杂触发必须将该数据移出
总线。在 PICkit 3 编程器 / 调试器中是否也需要这样做？例如，我是否可以根据变
为高电平的标志来暂停？

MPLAB ICE 2000/4000 调试器使用特殊调试器芯片 （-ME）进行监视操作。在
PICkit 3 编程器 / 调试器中没有 -ME，所以没有用于外部监视的总线。对于 PICkit 
3 编程器 / 调试器，可以使用调试引擎的内置断点电路而非外部断点——在该设备
内部监视总线和断点逻辑。

• PICkit 3 编程器 / 调试器是否具有像 MPLAB ICE 2000/4000 一样的复杂断点？

是的。您可以根据数据存储单元或程序地址单元中的值进行中断。更多信息可参见
第 9.3.1 节 “Breakpoints 对话框”。

• PICkit 3 是否需要光电或电气隔离？

不。不能对当前系统施加浮动电压或高电压 （120V）。

• 对标准电缆有何限制？

标准 ICSP RJ-11 电缆不允许时钟速度大于约 15 Mbps。
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• PICkit 3 是否会降低程序运行速度？

不会，器件将以数据手册中指定的任何器件速度运行。

• 是否可以调试以任何速度运行的 dsPIC DSC？

PICkit 3 能够以器件数据手册中指定的任何器件速度进行调试。

• 引脚 6 （即 LVP 引脚）有何功能？

引脚 6 是为 LVP （低电压编程）连接保留的。 

7.3 出现的问题

• 我的 PC 进入掉电／休眠模式，且现在调试器无法工作。发生了什么事情？

当长时间使用调试器，特别是作为调试器使用时，请确保在 PC 操作系统的 Power 
Option （电源选项）对话框窗口中禁止了 Hibernate （休眠）模式。请转到
Hibernate 选项卡并清除或取消选中 “Enable hibernate”（启用休眠）复选框。 
这会确保在所有的 USB 子系统组件上保持所有通信。

• 我将外设设置为不要在暂停时冻结，但是它突然冻结了。怎么办？

对于 dsPIC30F/33F 和 PIC24F/H 器件，外设控制寄存器中的保留位（通常是 bit 14 
或 bit 5）用作调试器使用的冻结位。如果您对整个寄存器执行写操作，就可能改写
此位。（在调试模式下用户可访问此位。）

要避免这个问题，可以只写想要为应用程序更改的位 （BTS和 BTC），而不是写
整个寄存器 （MOV）。

• 在使用 16 位器件时，发生了意外复位。我该如何判断产生该操作的原因？

可以考虑以下几个方面：

- 要确定复位源，请检查 RCON 寄存器。

- 处理中断服务程序 （Interrupt Service Routine， ISR）中的陷阱 / 中断。应该
包含 trap.c形式的代码，即：

  void __attribute__((__interrupt__)) _OscillatorFail(void);
          :
   void __attribute__((__interrupt__)) _AltOscillatorFail(void);
          :
   void __attribute__((__interrupt__)) _OscillatorFail(void)
   {
        INTCON1bits.OSCFAIL = 0;        //Clear the trap flag
        while (1);
   }
          :
   void __attribute__((__interrupt__)) _AltOscillatorFail(void)
   {
        INTCON1bits.OSCFAIL = 0;
        while (1);
   }
          :

- 使用 ASSERT。
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• 我已经完成了代码调试。现在也已编程了器件，但是它不运行。出了什么问题？

可以考虑以下几个方面：

- 您是否选择该调试器作为编程器然后尝试编程仿真头板？仿真头板包含器件的
-ICE/-ICD 版本，它们也许不能像实际器件一样工作。调试器作为编程器时，
只能编程常规器件。常规器件包括具有内置 ICE/ICD 电路的器件，而非仿真头
板上的特殊 -ICE/-ICD 器件。

- 您是否选择该调试器作为调试器然后尝试编程生产器件？当该调试器用作调试
器时，编程器件会将调试执行程序烧写到程序存储器中并为调试设置其他器件
功能 （见第 2.6.1 节 “进入调试模式的操作顺序”）。要烧写最终 （发布）代
码，应选择将该调试器用作编程器。

- 您是否从 Build Configuration 下拉列表或项目菜单中选择了 “Release”？对
于最终 （发布）代码，您必须这样做。重新编译项目、重新编程器件，并尝
试再次运行代码。

• 在这里找不到我遇到的问题。现在该怎么办？

尝试以下资源：

- 第 9 章 “调试器功能汇总”

- 第 2.8 节 “调试器使用的资源”

- 第 8.2 节 “特殊错误消息”

- 第 8.3 节 “常规纠正措施”
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注：
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第 8 章  错误消息

8.1 简介

PICkit 3 编程器 / 调试器会产生许多不同的错误消息；其中一些错误消息比较特殊而其
他的都可以用常规纠正措施解决。

• 特殊错误消息

• 常规纠正措施

8.2 特殊错误消息

PICkit 3 编程器 / 调试器错误消息按照数字序号列示如下。

下面错误消息中 %x （变量）形式的文本将显示为与实际错误消息中特殊情形相关的
文本。

PK3Err0001: Failed while writing to program memory. （写程序存储器失败。）

PK3Err0002: Failed while writing to EEPROM. （写 EEPROM 失败。）

PK3Err0003: Failed while writing to configuration memory. （写配置存储器失
败。）

请参见第 8.3.1 节 “读／写错误纠正措施”。

PK3Err0005: PICkit 3 is currently busy and cannot be unloaded at this time.
（PICkit 3 目前忙，此时无法卸载。）

如果您尝试取消选择该调试器作为调试器或编程器时收到此错误：

1. 等待——给调试器时间来完成所有应用任务。然后再次尝试取消选择调试
器。

2. 选择 Halt 来停止任何正在运行的应用程序。 然后再次尝试取消选择调试器。

3. 从 PC 拔出调试器。然后再次尝试取消选择调试器。

4. 关闭 MPLAB IDE。
PK3Err0006: Failed while writing to user ID memory. （写用户 ID 存储器失败。）

PK3Err0007: Failed while reading program memory. （读程序存储器失败。）

PK3Err0008: Failed while reading EEPROM. （读 EEPROM 失败。）

PK3Err0009: Failed while reading configuration memory. （读配置存储器失败。）

PK3Err0010: Failed while reading user ID memory. （读用户 ID 存储器失败。）

请参见第 8.3.1 节 “读／写错误纠正措施”。

PK3Err0011: Bulk erase failed. （批量擦除失败。）

请参见第 8.3.1 节 “读／写错误纠正措施”。

如果这些都不能解决问题，请尝试使用其他器件。

注： 数字序号也许不会出现在显示的消息中。使用 Help 查看器上的 Search
（搜索）选项卡来查找消息并突出显示如下。
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PK3Err0012: Download debug exec failed （下载调试执行程序失败）

如果您尝试从 Debugger 菜单进行编程时收到此错误：

1. 取消选择该调试器作为调试工具。

2. 关闭项目，然后关闭 MPLAB IDE。
3. 重启 MPLAB IDE 并重新打开项目。

4. 重新选择调试器作为调试工具并再次尝试编程目标器件。

如果这不能解决问题，请参见第 8.3.4 节 “安装程序损坏纠正措施”。

PK3Err0013: NMMR register write failed. （NMMR 寄存器写失败。）

PK3Err0014: File register write failed. （文件寄存器写失败。）

请参见第 8.3.2 节“调试器——目标器件通信错误纠正措施”。

PK3Err0015: Data transfer was unsuccessful. %d byte(s) expected, %d byte(s) 
transferred. （数据传输失败。需要 %d 字节，传输了 %d 字节。）

请参见第 8.3.3 节 “调试器——PC 通信错误纠正措施”。

PK3Err0016: Cannot transmit. PICkit 3 not found.（无法发送。找不到 PICkit 3。）

调试器未连接到 PC。

PK3Err0017: File register read failed. （文件寄存器读失败。）

PK3Err0018: NMMR register read failed. （NMMR 寄存器读失败。）

PK3Err0019: Failed while reading emulation registers. （读仿真寄存器失败。）

PK3Err0020: Failed while writing emulation registers. （写仿真寄存器失败。）

请参见第 8.3.2 节“调试器——目标器件通信错误纠正措施”。

PK3Err0021: Command not echoed properly. Sent %x, received %x.（无法正确回
传命令。发送了 %x，接收了 %x。）

PK3Err0022: Failed to get PICkit 3 version information. （无法获取 PICkit 3 版本
信息。）

PK3Err0024: Download RS failed. （下载 RS 失败。）

PK3Err0025: Download AP failed. （下载 AP 失败。）

请参见第 8.3.3 节 “调试器——PC 通信错误纠正措施”。

PK3Err0026: Download program exec failed. （下载编程执行程序失败。）

如果您尝试从 Debugger 菜单进行编程时收到此错误：

1. 取消选择该调试器作为调试工具。

2. 关闭项目，然后关闭 MPLAB IDE。
3. 重启 MPLAB IDE 并重新打开项目。

4. 重新选择调试器作为调试工具并再次尝试编程目标器件。

如果这不能解决问题，请参见第 8.3.4 节 “安装程序损坏纠正措施”。

PK3Err0027: Bulk transfer failed due to invalid checksum （无效校验和导致批量
传输失败）

请参见第 8.3.3 节 “调试器——PC 通信错误纠正措施”。

而且，请确保使用的电缆的长度正确。

PK3Err0028: Download device database failed （下载器件数据库失败）

如果您收到此错误：

1. 再次尝试下载。 可能是个一次性错误。

2. 尝试手动下载。 选择 Debugger>Settings 中的 Configuration 选项卡，单击
Manual Download（手动下载）。 选择编号最高的 .jam文件并单击 Open。
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PK3Err0029: Communication failure. Unexpected command echo response %x 
received from PICkit 3. （通信失败。从 PICkit 3 收到不希望的命令回传响应 %x。）

请参见第 8.3.3 节 “调试器——PC 通信错误纠正措施”。

PK3Err0030: Unable to read/find firmware File %s.（无法读／找到固件文件 %s。）

如果此 Hex 文件存在：

• 重新连接并再次尝试。

• 如果这不能解决问题，则文件可能损坏。 重新安装 MPLAB IDE。
如果 Hex 文件不存在：

• 重新安装 MPLAB IDE。
PK3Err0031: Failed to get PC. （无法找到 PC。）

PK3Err0032: Failed to set PC. （无法设置 PC。）

请参见第 8.3.2 节“调试器——目标器件通信错误纠正措施”。

PK3Err0033: %d bytes expected, %d bytes received.（需要 %d 字节，收到 %d 字节。）

请参见第 8.3.3 节 “调试器——PC 通信错误纠正措施”。

PK3Err0034: This version of MPLAB IDE does not support hardware revision %06x. 
Please upgrade to the latest version of MPLAB IDE before continuing. （该版本的
MPLAB IDE 不支持硬件版本 %06x。请升级至最新版本的 MPLAB IDE，然后继续。）

在 www.microchip.com 上找到最新的 MPLAB IDE。
PK3Err0035: Failed to get Device ID. （无法获得器件 ID。）

请参见第 8.3.1 节 “读／写错误纠正措施”。

PK3Err0036: MPLAB IDE has lost communication with PICkit 3.（MPLAB IDE 失
去与 PICkit 3 的通信。）

请参见第 8.3.3 节 “调试器——PC 通信错误纠正措施”。

PK3Err0037: Timed out waiting for response from PICkit 3. （等待 PICkit 3 响应超时。）

PK3Err0038: Failed to initialize PICkit 3. （无法初始化 PICkit 3。）

PK3Err0039: PICkit 3 self-test failed. （PICkit 3 自检失败。）

对于此错误，调试器不响应：

1. 拔出调试器然后插入。

2. 在 MPLAB IDE 中重新连接到调试器。

3. 如果问题仍然存在，请联系 Microchip。
PK3Err0040: The target device is not ready for debugging. Please check your 
configuration bit settings and program the device before proceeding.（目标器件
未准备好调试。请检查配置位设置并编程该器件，然后继续。）

当您首次使用器件而未对其进行编程并尝试运行时将收到此消息。如果您之后再
收到此消息，或者在编程器件之后立即收到此消息，请参见第 8.3.6 节 “调试故
障纠正措施”。

PK3Err0043: RS download failed. （RS 下载失败。）

PK3Err0044: AP download failed. （AP 下载失败。）

PK3Err0045: You must connect to a target device to use PICkit 3.（必须连接到目
标器件才能使用 PICkit 3。）

找不到电源。

1. 确保调试器和目标器件之间连接了 VDD 和 GND。

2. 确保目标器件上电。

3. 确保目标电源足以被调试器检测到（见第 10 章 “硬件规范”）。

PK3Err0046: An error occurred while trying to read the stopwatch count. The stopwatch 
count may not be accurate. （尝试读跑表计数时发生错误。跑表计数可能不准确。）

http://www.microchip.com/mplab
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请参见第 8.3.2 节“调试器——目标器件通信错误纠正措施”。

PK3Err0047: Bootloader download failed. （下载自举程序失败。）

请参见第 8.3.3 节 “调试器——PC 通信错误纠正措施”。

PK3Err0052: The current PICkit 3 hardware version %x, is out of date. This 
version of MPLAB IDE will support only version %x or higher. （当前的 PICkit 3
硬件版本 %x 过时。此版本的 MPLAB IDE 只支持 %x 版本或更高版本。）

在要求下载最新固件时是否单击了 Cancel （取消）？ 如果是，你需要现在下载
它。 选择 Debugger>Settings 中的 Configuration 选项卡，单击 Manual 
Download。 选择编号最高的 .jam文件并单击 Open。
如果您无法找到任何要下载的文件或者如果这不能解决问题 （文件损坏），您需
要获得最新版本的 MPLAB IDE 并安装它。 在 www.microchip.com 上找到最新的
MPLAB IDE。

PK3Err0053: Failed to get PICkit 3 protocol versions. （无法获取 PICkit 3 协议版
本。）

请参见第 8.3.3 节 “调试器——PC 通信错误纠正措施”。

PK3Err0054: MPLAB IDE's PICkit 3 protocol definitions are out of date. You must 
upgrade MPLAB IDE to continue. （MPLAB IDE 的 PICkit 3 协议定义过时。您必须
升级 MPLAB IDE，然后继续。）

在 www.microchip.com 上找到最新的 MPLAB IDE。
PK3Err0055: Unable to set firmware suite version. （无法设置固件包版本。）

PK3Err0056: Unable to get voltages from PICkit 3. （无法获得 PICkit 3 的电压。）

请参见第 8.3.3 节 “调试器——PC 通信错误纠正措施”。

PK3Err0068: Failed while writing to boot FLASH memory. （写引导闪存失败。）

PK3Err0069: Failed while reading boot FLASH memory. （读引导闪存失败。）

PK3Err0070: Failed while writing peripheral memory. （写外设存储器失败。）

PK3Err0071: Failed while reading peripheral memory. （读外设存储器失败。）

请参见第 8.3.1 节 “读／写错误纠正措施”。

PK3Err0073: Device is code protected. （器件受到代码保护。）

您尝试进行操作 （读、编程、空白检查或校验）的器件受到代码保护，即，无
法读或修改代码。 检查配置位设置，看是否使能了代码保护。

要禁止代码保护，请根据器件数据手册，在代码中或 Configuration Bits 窗口 
（Configure>Configuration Bits）中置 1 或清零相应的配置位。 然后擦除并重新
编程整个器件。

PK3Err0075: Unable to set power. （无法设置电源。）

PICkit 3 无法为目标器件供电。

PK3Err0080: Failed setting shadow bit(s). （设置影子位失败。）

8.3 常规纠正措施

以下这些常规纠正措施可以解决您的问题：

• 读／写错误纠正措施

• 调试器——目标器件通信错误纠正措施

• 调试器——PC 通信错误纠正措施

• 安装程序损坏纠正措施

• USB 端口通信错误纠正措施

• 调试故障纠正措施

• 内部错误纠正措施

http://www.microchip.com/mplab
http://www.microchip.com/mplab
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8.3.1 读／写错误纠正措施

如果您收到读或写错误：

1. 您是否点击了 Abort （中止）？ 这会产生读／写错误。

2. 再次尝试读／写操作。可能是个一次性错误。

3. 确保目标器件上电且处于器件的正确电压值。 请参见器件数据手册以了解需要的
器件电压值。

4. 确保调试器与目标器件的连接正确 （连接了 PGC 和 PGD）。

5. 对于写故障，请确保在 Settings 对话框的 Program Memory （程序存储器）选
项卡上选择了 “Erase all before Program”（编程前擦除所有存储区）。

6. 请确保使用的电缆的长度正确。

8.3.2 调试器——目标器件通信错误纠正措施

PICkit 3 编程器 / 调试器和目标器件彼此不同步。

1. 选择 Reset （复位），然后再次尝试此操作。

2. 请确保使用的电缆的长度正确。

8.3.3 调试器——PC 通信错误纠正措施

PICkit 3 编程器 / 调试器和 MPLAB IDE 彼此不同步。

1. 拔出调试器然后插入。

2. 重新连接调试器。

3. 再次尝试此操作。此错误也许是个一次性问题。

4. 安装的 MPLAB IDE 版本可能与 PICkit 3 编程器 / 调试器上装载的固件版本不
符。 遵循第 8.3.4 节 “安装程序损坏纠正措施”中列出的步骤。

8.3.4 安装程序损坏纠正措施

该问题最有可能因 MPLAB IDE 的安装程序不完整或损坏引起。

1. 从 PC 卸载 MPLAB IDE 的所有版本。

2. 重新安装需要的 MPLAB IDE 版本。

3. 如果问题仍然存在，请联系 Microchip。

8.3.5 USB 端口通信错误纠正措施

该问题最有可能因通信端口发生故障或不存在引起。

1. 重新连接 PICkit 3 编程器 / 调试器。

2. 确保调试器物理连接到 PC 的正确 USB 端口。

3. 确保在调试器设置中选择了正确的 USB 端口。

4. 确保该 USB 端口没有被其他器件使用。

5. 如果使用了 USB 集线器，请确保它已上电。

6. 确保装载了 USB 驱动程序。

8.3.6 调试故障纠正措施

PICkit 3 编程器 / 调试器无法执行调试操作。发生此问题有许多原因。 请参见第 6.3 节
“不能调试的头 10 个原因”和第 6.4 节 “要考虑的其他事项”。
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8.3.7 内部错误纠正措施

内部错误是不希望的，最好不要发生。 它们主要用于 Microchip 的内部开发。

最有可能的原因是安装程序损坏 （第 8.3.4 节 “安装程序损坏纠正措施”）。

另一个可能原因是系统资源耗尽。

1. 尝试重新启动系统来释放存储空间。

2. 确保您的硬盘上有适当的可用空间 （并且没有过多的磁盘碎片）。

如果问题仍然存在，请联系 Microchip。
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注：
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第 9 章  调试器功能汇总

9.1 简介

本章列出了菜单上、窗口中和对话框上的 PICkit 3 编程器 / 调试器功能汇总。

• 调试功能

• 调试对话框／窗口

• 编程功能

• Settings 对话框

9.2 调试功能

从 Debugger 菜单选择 PICkit 3 后，以下各项就会被添加 MPLAB IDE 功能中：

• Debugger 菜单——下拉菜单中添加了其他选项

• 鼠标右键调试器菜单——此菜单中添加了其他选项

• 工具栏／状态栏——工具栏显示在菜单栏下方；而状态栏中显示了其他信息

9.2.1 Debugger 菜单

Run F9 （运行）

执行程序代码直到遇到断点或选择 Halt。
从当前程序计数器 （如状态栏所示）开始执行。当前程序计数器的位置也可用
Program Memory （程序存储器）窗口中的一个箭头表示。程序运行时，将会禁止其
他几项功能。

Animate （连续单步执行）

Animate 使得调试器在运行程序时实际进行单步执行，在运行时会更新寄存器的值。

Animate 比 Run 功能运行速度慢，但这样做可在 Special Function Register （特殊功
能寄存器）窗口或 Watch （观察） 窗口中查看寄存器值的变化。

要暂停 Animate 功能，应使用菜单选项 Debugger>Halt （调试器 > 暂停）、工具栏上
的 Halt 或 <F5> 键。

Halt F5

暂停 （停止）程序代码的执行。单击 Halt 时，将更新状态信息。

Step Into F7 （单步执行）

单步执行程序代码。

对于汇编代码，此命令执行一条指令 （单周期指令或多周期指令）后暂停。在执行了
一条指令后，所有窗口都被更新。
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对于 C 代码，此命令执行一行 C 代码，这意味着执行一条或多条汇编指令，然后暂
停。 执行完成后，所有窗口都被更新。

Step Over F8 （单步跳过）

执行当前程序计数器位置处的指令。 对于 CALL指令， Step Over 执行被调用的子程序
并在 CALL指令后的地址处暂停。如果 Step Over 太长或出现 “挂起”，单击 Halt。

Step Out （单步跳出）

不可用。

Reset > Processor Reset F6 （复位 > 处理器复位）

发送 Reset 序列到目标处理器。这将发出 MCLR 信号将程序计数器复位到复位向量。

Breakpoints （断点）

打开 Breakpoint 对话框 （见第 9.3.1 节 “Breakpoints 对话框”）。 使用硬件断点以
在代码的指定行处暂定代码执行。 在此对话框中设置多个断点。

Program （编程）

下载代码到目标器件。

Read （读）

读目标存储器。上传到 MPLAB IDE 的信息。

Erase Flash Device （擦除闪存器件）

擦除闪存中的所有存储单元。

Abort Operation （中止操作）

中止任何编程操作 （例如，编程和读等）。 终止操作将使器件处于未知状态。

Reconnect （重新连接）

尝试重新建立 PC 和 PICkit 3 编程器 / 调试器之间的通信。这个连接的进度显示在
Output 对话框的 PICkit 3 选项卡上。

Settings

打开 PICkit 3 Settings 对话框 （见第 9.5 节 “Settings 对话框”）。设置编程和固件
选项。

注： 不要 Step into （单步执行） SLEEP指令。

注： 也可右击或双击代码行来设置单个断点。
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9.2.2 鼠标右键调试器菜单

在代码显示 （如程序存储器和源代码文件）中，鼠标右键菜单包括以下这些调试器菜
单选项。 这里未列出的其他菜单选项的说明可在 MPLAB IDE 帮助或 MPLAB 编辑器帮
助中找到。

Set Breakpoint （设置断点）

在当前所选行上设置或移除断点。

Breakpoints

移除、启用或禁用所有断点。

Run To Cursor （运行到光标）

运行程序到当前光标位置。 以前称为 Run to Here （运行到此）。

Set PC at Cursor （将 PC 设置在光标处）

将程序计数器 （PC）设置到光标位置。

Center Debug Location （调试位置居中）

将窗口中的当前 PC 行居中。

9.2.3 工具栏／状态栏

当选择 PICkit 3 编程器 / 调试器作为调试器时，这些工具栏将显示在 MPLAB IDE 中：

• 基本调试工具栏 （Run、 Halt、 Animate、 Step Into、 Step Over、 Step Out、
Reset 和 Breakpoints）。

• 简单的编程工具栏 （Program、 Read 和 Erase Flash Device）。

选中的调试工具 （PICkit 3）以及其他开发信息显示在 MPLAB IDE 桌面底部的状态栏
中。请参见 MPLAB IDE 在线帮助以了解关于状态栏内容的信息。

9.3 调试对话框／窗口

使用第 9.2 节 “调试功能”中提到的菜单项打开以下调试对话框和窗口。

• Breakpoints 对话框

- Set Breakpoint 对话框

- Stopwatch 对话框

- Event Breakpoints 对话框

9.3.1 Breakpoints 对话框

要设置断点，应选择 Debugger>Breakpoints。
在此对话框中设置不同类型的断点。 单击 Add Breakpoint （添加断点）来添加断点
到对话框窗口。可能有用于更高级断点选项的其他按钮，这取决于您选择的器件。
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9.3.1.1 BREAKPOINT 对话框窗口

该窗口显示关于各个断点的信息。

断点添加到窗口中以后，您可以右击它来打开菜单选项：

• Delete （删除）——删除选中的断点

• Edit/View （编辑 / 查看）——打开 Set Breakpoint 对话框

• Delete All （删除所有）——删除所有列出的断点

• Disable All （禁用所有）——禁用所有列出的断点

9.3.1.2 BREAKPOINT 对话框按钮

使用按钮添加断点和设置其他中断条件。而且，还提供了跑表功能以与断点和触发结
合使用。 

表 9-1： BREAKPOINT 对话框窗口

控制 功能

Breakpoint Type （断点类型） 断点类型——程序或数据

Address （地址） 断点位置的十六进制地址

File Line #/Symbol Name （文件行号 / 符号名） 断点位置的文件名和行号

Enabled （启用） 选中以启用断点

注： 显示的按钮取决于选中的器件。

表 9-2： BREAKPOINT 对话框按钮

控制 功能 相关对话框

Add Breakpoint 添加断点 第 9.3.2 节 “Set Breakpoint 对话框”

Stopwatch （跑表） 设置跑表 第 9.3.3 节 “Stopwatch 对话框”

Event Breakpoints
（事件断点）

设置事件中断 第 9.3.4 节 “Event Breakpoints 对话框”



调试器功能汇总

 2009 Microchip Technology Inc. DS51795A_CN 第 53 页

9.3.2 Set Breakpoint 对话框

在 Breakpoints 对话框中单击 Add Breakpoint 来显示该对话框。

在此为 Breakpoints 对话框选择断点。

9.3.2.1 PROGRAM MEMORY 选项卡

在此设置程序存储器断点。

9.3.2.2 DATA MEMORY 选项卡

在此设置数据存储器断点。

表 9-3： 程序存储器断点

控制 功能

Address 十六进制的断点位置

Breakpoint Type 程序存储器断点类型。更多关于表读／表写的信息，请参见相应的
器件数据手册。
Program Memory Execution （程序存储器执行）——执行到上述
地址时中断
TBLRD Program Memory （TBLRD 程序存储器）——对上述地址
执行表读操作时中断
TBLWT Program Memory （TBLWT 程序存储器）——对上述地
址执行表写操作时中断

Pass Count （次数计数） 满足次数计数条件时中断。
Always break （始终中断）——始终按照在“Breakpoint type”
中指定的设置中断
Break occurs Count instructions after Event （事件发生后的 Count
条指令后中断）——在发生“Breakpoint type”中指定的事件之
后，要等待 Count （0-255）条指令后才中断
Event must occur Count times （事件必须发生 Count 次）——仅
在“Breakpoint type” 中指定的事件发生 Count （0-255）次后才
中断

表 9-4： 数据存储器断点

控制 功能

Address 十六进制的断点位置

Breakpoint Type 数据存储器断点类型。 更多关于 X 总线读／写的信息，请参见相应
的器件数据手册。
X Bus Read （X 总线读）——X 总线读上述地址时中断
X Bus Read Specific Byte （X 总线读特定字节）——X 总线读上
述地址得到在“Specific Value” （特定值）中指定的特定字节值
时中断
X Bus Read Specific Word （X 总线读特定字）——X 总线读上述
地址得到在“Specific Value” 中指定的特定字值时中断
X Bus Write （X 总线写）——X 总线写上述地址时中断
X Bus Write Specific Byte （X 总线写特定字节）——X 总线写上
述地址得到在“Specific Value”中指定的特定字节值时中断
X Bus Write Specific Word （X 总线写特定字）——X 总线写上述
地址得到在“Specific Value” 中指定的特定字值时中断

Pass Count 满足次数计数条件时中断。
Always break——始终按照在“Breakpoint type”中指定的设置中
断
Break occurs Count instructions after Event——在发生
“Breakpoint type”中指定的事件之后，要等待 Count （0-255）
条指令后才中断
Event must occur Count times——仅在 “Breakpoint type” 中指
定的事件发生 Count （0-255）次后才中断
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9.3.3 Stopwatch 对话框

在 Breakpoints 对话框中单击 Stopwatch 来显示跑表设置对话框。

使用跑表和断点来给代码执行计时。 跑表允许对一个断点／触发条件到下一个断点／
触发条件之间的时间计时。 跑表值是十进制的。

要在代码中设置断点，可执行以下任一操作：

• 要设置单独的断点，可双击或右击代码行。

• 选择 Debugger>Breakpoints 来打开 Breakpoints 对话框并设置多个断点和断点条
件。 更多信息请参见第 9.3.1 节 “Breakpoints 对话框”。

要确定断点间的时间间隔，可使用跑表功能：

1. 打开 Breakpoints 对话框 （Debugger>Breakpoints）。

2. 在 Breakpoints 对话框中单击 Stopwatch 来打开 Stopwatch 对话框。

3. 在 “Start Condition”下，从下拉列表中选择一个断点。 还要决定是否选中
“Start condition will cause the target device to halt”。

4. 在 “Stop Condition”下，从下拉列表中选择另一个断点。 还要决定是否选中
“Stop condition will cause the target device to halt”。

5. 决定是否选中 “Reset stopwatch on run”。

6. 单击 OK。

9.3.4 Event Breakpoints 对话框

在 Breakpoints 对话框中单击 Event Breakpoints 来显示该对话框。

选择一个使程序总是中断的条件：

• Break on Watchdog Timer （看门狗定时器超时时中断）——在每次看门狗定时器 
超时时中断。确保使用配置位启用了看门狗定时器。

• Break on SLEEP instruction （执行 SLEEP指令时中断）——当在程序中遇到
SLEEP指令时中断。

表 9-5： 跑表设置

控制 功能

Start Condition （启动条
件）

选择一个可用的断点或触发条件来启动跑表。可用的断点／触发是
先前添加到 Breakpoint 对话框中的。
选择 None （无）清除启动条件。 
要使程序在满足此条件时暂停，请选中“Start condition will cause 
the target device to halt”（启动条件将导致目标器件暂停） 旁边的
复选框。

Stop Condition （停止条
件）

选择一个可用的断点或触发条件来停止跑表。可用的断点／触发是
先前添加到 Breakpoint 对话框中的。
选择 None 清除停止条件。 
要使程序在满足此条件时暂停，请选中“Stop condition will cause 
the target device to halt”（停止条件将导致目标器件暂停） 旁边的
复选框。

Reset stopwatch on run
（运行时复位跑表）

在每次程序运行时将跑表值复位为零。
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9.4 编程功能

从 Programmer 菜单选择 PICkit 3 编程器 / 调试器后，编程相关的项就会被添加到以下
MPLAB IDE 功能中：

• Programmer 菜单

• 工具栏／状态栏

9.4.1 Programmer 菜单

Program

编程指定存储区： 程序存储器、配置位、 ID 单元和 / 或数据 EEPROM。 请参见 
Settings 对话框了解编程选项。

Verify （校验）

校验对指定存储区的编程： 程序存储器、配置位、 ID 单元和 / 或数据 EEPROM。

Read

读指定存储区： 程序存储器、配置位、 ID 单元和 / 或数据 EEPROM。 请参见 Settings
对话框了解读选项。

Blank Check All （空白检查全部）

检查所有器件存储区是否已被擦除 / 为空白。

Erase Flash Device

擦除闪存中的所有存储单元。

Abort Operation

中止任何编程操作 （例如，编程和读等）。 终止操作将使器件处于未知状态。

Reconnect

尝试重新建立 PC 和 PICkit 3 编程器 / 调试器之间的通信。这个连接的进度显示在
Output 对话框的 PICkit 3 选项卡上。

Settings

打开 Programmer 对话框 （见第 9.5 节 “Settings 对话框”）。 设置编程和固件选
项。

9.4.2 工具栏／状态栏

当选择 PICkit 3 编程器 / 调试器作为编程器时，这些工具栏将显示在 MPLAB IDE 中：

• 基本编程工具栏（Program、Read、Verify、Erase Flash Device 和 Blank Check 
All）。

选中的编程器 （PICkit 3）以及其他编程信息显示在 MPLAB IDE 桌面底部的状态栏
中。 请参见 MPLAB IDE 在线帮助以了解关于状态栏内容的信息。
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9.5 SETTINGS 对话框

选择 Debugger>Settings 或 Programmer>Settings 打开 Settings 对话框，设置 PICkit 
3 编程器 / 调试器。

• Settings 对话框， Program Memory 选项卡

• Settings 对话框， Configuration 选项卡

• Settings 对话框， Freeze on Halt （暂停时冻结）选项卡

• Settings 对话框， Status 选项卡

• Settings 对话框， Clock （时钟）选项卡

• Settings 对话框， Secure Segment （安全段）选项卡

• Settings 对话框， Warnings （警告）选项卡

• Settings 对话框， Power （电源）选项卡

• Settings 对话框， Limitations （限制）选项卡

9.5.1 Settings 对话框， Program Memory 选项卡

该选项卡允许您设置调试／编程选项。

注： 显示的选项卡取决于选中的器件。

表 9-6： 程序存储器选项
Allow PICkit 3 to select 
memories and ranges （允
许 PICkit 3 选择存储区和范
围）

选中时， PICkit™ 3 使用所选器件和默认设置确定要编程
的存储区和范围。

Manually select memories 
and ranges （手动选择存储
区和范围）

选中时，必须确定所选器件的存储区、程序存储器范围和
编程选项。

Memories （存储区）：

Program （程序） 选中时，烧写目标器件的程序存储器。

Configuration （配置） 选中时，烧写目标器件的配置位。
注：当将调试器选择作为调试器时总是烧写这个存储区。

EEPROM 选中时，擦除并随后烧写目标器件的 EEPROM 存储器
（如果有）。 不选中时，擦除目标器件上的 EEPROM 存储
器。

ID 选中时，烧写目标器件的 ID 存储区。

Boot Flash （引导闪存） 选中时，烧写目标器件的引导存储区（如果支持）。

Program Memory Range （程序存储器范围）：

Start （开始）和 End （结束） 程序存储器中要进行编程、读取或校验的存储区的十六进
制开始和结束地址范围。
如果接收到由于结束地址错误而产生编程错误的信息，则
需要重新连接、更正结束地址，并重新编程。
注：此地址范围不适用于擦除功能。 擦除功能将擦除器件
上的所有数据。

Program Options （编程选项）：

Erase all before Program 选中时，可在开始编程前先擦除所有存储区。
除非编程新的或已擦除的器件，否则都必须选中此复选
框。 如果未选中，则器件不会被擦除且程序代码会与器件
中已有的代码合并。

Preserve Program Memory 
Range （程序存储器的保存
范围）

选中时保存指定的存储区范围。
Start 和 End——程序存储器中要保存的存储区的十六进制
开始和结束地址范围。
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9.5.2 Settings 对话框， Configuration 选项卡

在此选项卡上配置调试器操作。

9.5.3 Settings 对话框， Freeze on Halt （暂停时冻结）选项卡

在此选项卡上选择外设在暂停时冻结。

PIC18 MCU 器件

要在暂停时冻结／解冻所有器件外设，可选中／不选中“Freeze on Halt” 复选框。 如
果这没有暂停所需的外设，应注意到有些外设没有在暂停时冻结的功能，而无法被调
试器控制。

dsPIC30F/33F、 PIC24F/H 和 PIC32MX 器件

对于 “Peripherals to Freeze on Halt” （暂停时冻结外设）列表中的外设，选中以在
暂停时冻结该外设。不选中该外设，将允许它在程序暂停时运行。如果在列表中没有
看到所需的外设，选中 “All Other Peripherals” （所有其他外设）。如果这没有暂停
所需的外设，应注意到有些外设没有在暂停时冻结的功能，而无法被调试器控制。

要选择所有外设（包括“All Other Peripherals”），请单击 Check All（全选）。 要取
消选择所有外设（包括“All Other Peripherals”），请单击 Uncheck All （全不选）。

9.5.4 Settings 对话框， Status 选项卡

在此选项卡上查看 PICkit 3 系统的状态。 

Automatically （设置自动选项）

Program after successful 
build （成功编译后编程）

应用程序代码在成功编译后被烧写到目标器件。

Run after successful program
（成功编程后运行）

应用程序代码在成功烧写到目标器件后运行。

表 9-7： 配置项

Download Firmware （下载固
件）

设置固件下载选项。

Auto Download Latest Firmware
（自动下载最新固件）

选中以允许自动下载目标器件的最新版本固件 （推荐）。

Manual Download （手动下载） 手动选择固件文件并下载到目标器件。

表 9-8： 状态项

Versions （版本）

Firmware Suite Version
（固件包版本）

调试器固件包版本。 固件包由下面指定的二项组成。

Algorithm Plug-in Version
（算法插件版本）

调试器算法插件版本。 对于选中的器件，可使用算法来支持将插入
到目标板的器件。

OS Version （OS 版本） 调试器操作系统版本。

Voltages （电压）

PICkit™ 3 VPP 调试器 VPP。

PICkit 3 VDD 调试器 VDD。

Refresh Voltages （刷新
电压）

在显示 Status 选项卡时即开始检测该选项卡项。 要查看更新，请单
击此按钮。

表 9-6： 程序存储器选项 （续）
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9.5.5 Settings 对话框， Clock （时钟）选项卡

在此选项卡上选择调试时钟模式。选中复选框“FRC in debug mode”（调试模式下使
用 FRC）以在调试时使用快速 RC 时钟。 
器件仿真以处理器速度运行。如果在低频 （例如 32 kHz）模式下运行，则所有操作
（例如单步执行和刷新 watch 窗口等）的速度都将放慢。但是，一些处理器具有内置
的快速 RC 振荡器。如果在以正常速度运行的应用程序暂停后选中了 “FRC in debug 
mode”选项，那么它将切换到能使仿真操作和外设 （如果未冻结）以更快速度运行的
快速振荡器模式。

9.5.6 Settings 对话框， Secure Segment （安全段）选项卡

对于 CodeGuard™ 安全器件，在该选项卡上设置安全段属性。

更多关于 CodeGuard 安全功能的详细信息，请参见我公司网站上提供的 16 位器件的
CodeGuard 安全参考手册 （DS70180A_CN）以及 dsPIC33F/PIC24H 和 dsPIC30F
器件编程规范。 

9.5.7 Settings 对话框， Warnings （警告）选项卡

在此选项卡上列出所有 PICkit 3 编程器 / 调试器警告。

• 选中一个警告以启用它。 该警告将显示在 Output 窗口中。

• 取消选中一个警告以禁用它。

警告不是错误，不会停止项目编译。如果收到错误消息，请查看第 8 章 “错误消息”。

9.5.8 Settings 对话框， Power （电源）选项卡

在此选项卡上设置电源选项。

单击此复选框，以启用／禁用“Power target circuit from PICkit 3” （由 PICkit 3 向目
标电路供电）。

可调整滑动条来选择电压。此字段中的值会随着您的调整而变化。

9.5.9 Settings 对话框， Limitations （限制）选项卡

此选项卡显示所选器件的一般限制。要查看详细的限制信息，请单击 Details （详细信
息）。

表 9-9： 安全段选项
Full Chip Programming
（全芯片编程）

单击选中以编程所有程序存储器段。

Segment Programming
（段编程）

单击选择要编程的段。 可选择：
- 引导段、安全段和通用段
- 安全段和通用段
- 仅通用段

http://www.microchip.com/codeguard
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第 10 章  硬件规范

10.1 简介

本章详述了 PICkit 3 编程器 / 调试器系统的硬件和电气规范。

10.2 重点

本章讨论了：

• 一致性声明

• USB 端口／电源

• PICkit 3 编程器 / 调试器

• 标准通信硬件

• 目标板注意事项

10.3 一致性声明

我公司

Microchip Technology, Inc.
2355 W. Chandler Blvd.
Chandler， Arizona 85224-6199
USA

特此声明：

假设 PICkit 3 编程器 / 调试器

符合操作手册中列出的限制，则该产品符合如下标准：

标准： EN61010-1 实验室设备
Microchip Technology, Inc.
日期：2009 年 1 月

关于使用 PICkit 3 编程器 / 调试器的重要信息

用户应当了解，基于 PICkit 3 编程器 / 调试器的特性，它所产生的电磁辐射会超过正 
常水平，从而会对各种类型的射频和其他设备产生干扰。

为了符合欧洲认证法规，必须满足如下限制：

1. 只有在工业环境 （或同等坏境）中使用该开发系统。

2. 禁止在距离可能会受到此类辐射干扰的任何设备 （射频接收器和电视机等） 20
米以内的范围使用该系统。
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10.4 USB 端口／电源

PICkit 3 编程器 / 调试器通过与 2.0 版本兼容的微型通用串行总线 （ Universal Serial，
USB）端口与 PC 主机连接。 USB 连接器位于调试器主机的顶部。

系统能够通过 USB 接口重载固件。

通过 USB 接口为系统供电。根据 USB 规范，该调试器被归类为高功耗系统，并且需
要通过 USB 提供略大于 100 mA 的电流，以使该调试器能在所有工作模式 （调试器／
编程器）下正常工作。

电缆长度——在调试器工具包里提供了正常工作所需的 PC －调试器电缆。

自供电的集线器——如果您想使用 USB 集线器，请确保它是自供电的。 而且， PC 键
盘上的 USB 端口不能为调试器正常工作提供足够的电源。

PC 休眠／掉电模式——禁止 PC 上的休眠或其他省电模式，以确保与调试器的正常
USB 通信。

10.5 PICKIT 3 编程器 / 调试器

调试器包含封装在外壳中的主电路板，带有一个 USB 连接器和一个单列直插式连接
器。 调试器外壳上有指示灯 （LED）。

10.5.1 主电路板

该组件带有集成 USB 2.0 接口的接口处理器、用于将程序代码烧写到仿真器件的内置
闪存中的 SPI 接口和串行 EE 以及 LED 指示灯。

10.5.2 指示灯 （LED）

指示灯具有如下含义。

注： PICkit 3 编程器 / 调试器通过其 USB 连接供电。目标板自己供电。 或者，
PICkit 3 仅在目标板消耗的电流小于 30 mA 的情况下为目标板供电。

LED 颜色 说明

Power （电源） 绿色 在开始上电或与目标板连接时点亮。

Active （活动） 蓝色 在 PICkit™ 3 已建立与 PC 的通信或发送 / 接收命令时点亮。

Status （状态） 绿色 在调试器正常工作 （待机）时点亮。

黄色 操作忙时点亮。 
红色 调试器失败时点亮。
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10.6 标准通信硬件

要使调试器与目标板之间进行标准通信 （第 2.3 节 “调试器与目标板之间的通信”中
的 “标准 ICSP 器件通信”），应使用带 RJ-11 连接器的适配器。

要在此类型的通信中使用仿真头板，您需要一个针对特定器件的处理器套件，它包括
一个 8 引脚的连接器仿真头板，仿真头板还包含了需要的 ICE/ICD 器件和标准适配器
电路板。

更多关于仿真头板的信息，请参见 “Header Board Specification”（DS51292）。

10.6.1 标准通信

标准通信接口是与目标处理器的主要接口。 它包含到高电压 （VPP）的连接、 VDD 检
测线以及烧写和连接目标器件所需的时钟和数据连接。

VPP 高电压线可生成电压范围为 1.8V 至 14V 的可变电压，以满足特定仿真处理器的
电压要求。 
VDD 检测连接从目标处理器汲取电流。 
时钟和数据连接是具有以下特性的接口：

• 时钟和数据信号处于高阻模式（即使在未向 PICkit 3 编程器 / 调试器系统施加电源
时也是如此）

• 时钟和数据信号可免受因目标系统有缺陷或连接不当引起的高电压的影响

• 时钟和数据信号可免受因样机或目标系统中的电气短路引起的大电流的影响

图 10-1： 6 引脚标准引脚排列

注： 以前的仿真头板使用 6 引脚 （RJ-11）连接器，而非 8 引脚连接器，所以
这些仿真头可以直接连接到调试器。

1

2

3

4

5

6
目标板
的底部

      标准插座

目
标

板

    目
标
器

件
 或

P
IM

引脚 名称 功能

1 MCLR/VPP 电源

2 VDD_TGT 目标板上的电源

3 GND 地

4 PGD
（ICSPDAT）

标准通信数据

5 PGC
（ICSPCLK）

标准通信时钟

6 LVP 低电压编程
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10.6.2 模块化电缆和连接器

在标准通信中使用模块化电缆连接调试器和目标应用。 下面列出了有关电缆及其连接
器的规范。

10.6.2.1 模块化连接器规范

• 制造商，部件编号——AMP Incorporated， 555165-1
• 代理商，部件编号——Digi-Key， A9031ND
图 10-2 中的表显示了某个应用中的模块化连接器引脚与单片机引脚的对应关系。 这种
配置提供了全部的 ICD 功能。

图 10-2： 目标板的模块化连接器引脚排列

10.6.2.2 模块化插头规范

• 制造商，部件编号——AMP 公司， 5-554710-3
• 代理商，部件编号——Digi-Key， A9117ND

模块化连接器引脚 单片机引脚

6 LVP

5 RB6

4 RB7

3 地

2 目标 VDD

1 VPP
1

6

目标板上模块化连接器引脚排列的

仰视图

1 6

目标板上模块化连接器的正视图

目标板
转换插座

器件 -ICE

AC164110
适配器

仿真头

电源

PICkit™ 3

连接到 PC 的
微型 USB电缆



硬件规范

 2009 Microchip Technology Inc. DS51795A_CN 第 63 页

10.6.2.3 模块化电缆规范

• 制造商，部件编号——Microchip Technology， 07-00024

10.7 目标板注意事项

应根据所选器件 （1.8V-5.0V）和应用的要求向目标板供电。

根据使用的调试器－目标板通信类型，目标板电路应考虑以下注意事项：

• 第 2.4.2 节 “目标板连接电路”

• 第 2.4.5 节 “影响调试器正常运行的电路”
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注：
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附录 A PICkit 3 原理图

本附录给出了 PICkit 3 开发编程器 / 调试器的原理图。 演示板的原理图可在相应的用户
指南中找到。

图 A-1： PICKIT™ 3 原理图 （第 1 页，共 2 页）
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图 A-2： PICKIT™ 3 原理图 （第 2 页，共 2 页）

U
SE
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附录 B 操作建议

在设计使用 PICkit 3 的应用时，应考虑以下这些操作问题：

• 振荡器电路设置

• ICSP™ 的实现和注意事项

• 建议配置

• 替换配置方案

• 通信通道

• 接地和交流应用

• 串扰的纠正措施

• 休眠

振荡器电路设置

主振荡器

MPLAB IDE 默认设置和独特目标器件要求之间的差异往往导致在 output 窗口中显示以
下消息“The target device is not ready for debugging. Please check your configuration 
bit settings and program the device before proceeding.”。要纠正这个问题，请将配置
位设置为与目标器件配置的振荡器设置相匹配。

对于调试操作，应用 （目标）振荡器必须在进行在线调试之前能够正常运行。确保正
确配置了振荡器配置和 MPLAB IDE 配置位设置。例如，如果您的应用使用了 20 MHz
的晶振，请在 MPLAB IDE 中选择 HS （高速）选项。 如需了解任何其他适用的器件振
荡器模式，请查询相应的器件数据手册。 

晶振

如果使用了 MPLAB ICD 仿真头或处理器扩展套件连接到目标器件，在启动晶振时也
许会出现问题。要避免这种可能发生的问题，请考虑以下操作：

1. 确保晶振靠近器件连接。

2. 保持目标应用中的所有线尽可能的短，避免不必要的间断，例如 PCB 过孔和测
试点。

3. 最大程度地降低这些节点上的容性负载。

4. 避免在晶振和电容的位置使用插座。直接将器件焊接到 PCB 焊盘上。

ICSP™ 的实现和注意事项

PICkit 3 使用串行信号模式来编程和调试目标器件。使用的信号是时钟和数据信号。 在
多数器件中，它们也可以映射到端口 （通常是 RB6 和 RB7），但是在一些数据手册中
它们也定义为 PGC 和 PGD 或 ICSPCLK 和 ICSPDAT。
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此外， MCLR 也用作高电压编程信号或用作器件的注意指示信号。

为了避免在线调试过程中出现问题，设计人员必须仔细规划，避免在应用开发或产品
的生产阶段出现任何问题。

建议配置

信号 PGC 和 PGD 是由 PICkit 3 和目标仿真器件驱动的有源双向信号。如果这些信号
保持与应用中任何其他无源电路或有源逻辑隔离，那么将确保调试和编程会话过程中
不会出现问题。 而且，采用此配置可能无需考虑电缆长度和 / 或类型。 
另外，PICkit 3 可以使用 MCLR 信号来提供编程某些器件所需的电压或用作注意信号。 
在应用具有大电容的情况下，这会产生信号上升和下降时间以使信号降级。 这还将妨
碍 PICkit 3 与器件有效通信的能力。 建议使用一个 10K 的电阻保持信号上拉到 VDD，
并利用器件的上电复位定时器功能来确保上电顺序正确。

替换配置方案

在某些情形下，特别是采用了低引脚数器件的情形下，应用必须使用引脚。

如果是这种情况，至少要求在器件和应用有效节点之间进行电阻隔离。 这将确保应用
电路和 PICkit 3 都能够将 PGC 或 PGD 节点驱动为地电势或正确的 VDD 电平。图 B-1
说明了此配置。

图 B-1： 典型的 ICSP™ 应用电路

隔离电阻值因应用和使用方式而异。 建议值范围为 1K 到 10K。 在任何情况下，请确保
PGD 和 PGC 能够驱动为合适的逻辑电平。

通信通道

一些器件能够灵活地使用多个通信通道或引脚中的一个来进行编程和调试。这些通道
在数据手册中通常称为 PGCx/PGDx，其中 x 是通道号标识符。 这些通道常常是与某
些外设（I2C™、SPI 或 A/D）复用的。 如果应用中使用了这些外设和引脚（通常是默
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认的 PGC/PGD 引脚），那么必须为所需的 ICSP 连接选择其他通道并进行相应配置。

同样地，在使用 MPLAB IDE 与使用此新通道引脚分配的目标器件通信时，必须确保
MPLAB IDE 中的配置位与目标器件中的连接通道相匹配。

接地和交流应用

PICkit 3 从 USB 连接器接口通过 PC 连接到地。

在不以地为参考的交流线供电的应用中，这种接地路径会导致系统电压电势不同，从
而破坏这两个系统。 在这种情况下，必须隔离 PICkit 3。 请在连接 PICkit 3 和目标板之
前仔细考虑地系统和信号返回连接。

在热或悬空应用中，应在 PC 和 PICkit 3 之间使用 USB 自供电的隔离集线器，以通过
USB 电缆与 PC 地隔离 （见图 B-2）。 建议的 USB 隔离集线器如下：

• 高 / 低速 4 端口 USB 集线器，型号 UISOHUB 4， B&B Electronics Mfg. Co.
• 高速 7 端口 USB 集线器，型号 HUB7P， SEALEVEL Systems, Inc.

图 B-2： 无隔离交流电源系统的 PICKIT™ 3 设置示例

警告

在没有确保地隔离的情况下，使用 PICkit 3 会导致损坏 PICkit 3 或目标系

统，因为这将对其施加完整的交流电源电压。
这种情况非常危险，有可能导致操作人员触电。 因此，应采取足够的预防措

施来避免这种情形出现。

PC

交流

交流

光隔离的
自供电

PICkit 3
目标
应用

       地

目标地

USB 集线器

热

警告

在图 B-2 中，使用光隔离的 USB 集线器会产生一个以点线标记的热区。

这种情况非常危险，有可能导致操作人员触电，因此，应采取足够的预防措
施来避免这种情形出现。
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串扰的纠正措施

在某些情形下，编程器件时会存在串扰问题。 由于 PGC 和 PGD 引脚的位置，串扰可
能会使信号降级并导致 PICkit 3 对目标器件编程失败。 要纠正这个问题，请尝试以下
操作：

• 构造 RJ12 模块化电缆连接。 保持电缆长度尽可能短，最好短于 6 英寸。 还应除去
电缆外壳，以便导线相互远离 （特别是 PGC 和 PGD 信号线）。 标准模块化电缆
的连线方式如图 B-3 所示，即 RJ12 一端的引脚 1 连接到另一端的引脚 6。 这解决
了几乎所有情形下的此类问题。

图 B-3： 目标连接器引脚排列

休眠

长时间使用 PICkit 3，特别是当调试器处于仿真模式时，请在 PC 操作系统的 Power 
Option 对话框窗口中禁止了 Hibernate 模式。 单击 Hibernate 选项卡并清除或取消选
中 “Enable hibernation”复选框。 这会确保在所有的 USB 子系统组件上保持所有通
信。

1

2

3

4

5

6

目标
连接器

目标

底部

Vpp/MCLR
Vss

PGC
Vdd

PGD
LVP

PCB

注 1： 高噪声设备 （电机或调光器等）必须位于与目标应用和 PICkit 3 隔离的
单独功率板上。
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术语表

ANSI

美国国家标准学会，是美国负责制订和批准标准的组织。

ASCII

美国信息交换标准码是使用 7 个二进制位来表示每个字符的字符集编码。 它包括大写
和小写字母、数字、符号以及控制字符。

Build

编译并链接一个应用程序的所有源文件。

八进制 （Octal）
仅使用数字 0-7、以 8 为基数的计数体制。最右边的位表示 1 的倍数，右侧第二位表
示 8 的倍数，右侧第三位表示 82 = 64，以此类推。

本机数据长度 （Native Data Size）
对于本机路径， Watch 窗口中使用的变量长度必须与所选器件的数据存储器的长度相
同： PIC18 器件以字节计，而 16 位器件以字计。

编译器 （Compiler）
将用高级语言编写的源文件翻译成机器码的程序。

表达式 （Expressions）
以算术或逻辑运算符分隔的常数和 / 或符号的组合。

标识符 （Identifier）
函数或变量名。

不提倡使用的功能 （Deprecated Features）
由于旧版本的原因仍然支持，但是最终将逐步淘汰而不再使用的功能。

C

具有表达式简练、先进的控制流程和数据结构，以及运算符丰富等特点的通用编程语
言。

Clean （清除）

在 MPLAB IDE 项目菜单下，单击 Clean 会移除所有中间项目文件，例如活动项目的
目标文件、 hex 文件和调试文件。 当编译项目时，这些文件可从其他文件重新创建。

COFF

公共目标文件格式。 这种格式的文件包含机器码、调试信息和其他信息。

CPU

请参见中央处理单元。
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操作码 （Opcode）
操作码 （Operational Code）。 请参见助记符。

插件 （Plug-in）
MPLAB IDE 使用其内含组件和插件模块来为各种软件和硬件工具配置系统。 在 Tools
（工具）菜单下可找到多个插件工具。

场景 （Scenario）
在 MPLAB SIM 软件模拟器中，用于激励控制的特定设置。

程序存储器 （Program Memory）
器件中存储指令的存储区。 另外，调试器或软件模拟器中的存储器包含下载的目标应
用程序固件。

程序计数器 （Program Counter）
包含当前执行指令地址的地址单元。

程序计数器单元 （Program Counter Unit）
程序存储器构成的概念化表示。 每个指令字使程序计数器递增 2。 在可执行段中，2 个
程序计数器单元相当于 3 个字节。 在只读段中，2 个程序计数器单元相当于 2 个字节。

持久性数据 （Persistent Data）
从不被清除或初始化的数据。它主要用于使应用在器件复位时依然能保存数据。

重定位 （Relocation）
是链接器执行的一个步骤，在此步骤中，绝对地址被分配给可重定位段，而且可重定
位段中的所有符号均被更新到新地址。

触发输出 （Trigger Output）
触发输出指可在任意地址或地址范围产生的调试器输出信号，与跟踪和断点的设置无
关。可设置任意个触发输出点。

初始化数据 （Initialized Data）
定义时具有初始值的数据。 在 C 中，

int myVar=5;

定义了将存放到初始化数据段的一个变量。

次数计数器 （Pass Counter）
每次一个事件 （如执行特定地址处的一条指令）发生时都会递减 1 的计数器。 当次数
计数器的值为零时，事件满足。 可将次数计数器分配给断点和跟踪逻辑，以及在
Complex Trigger （复杂触发）对话框中的任何连续事件。

存储类别 （Storage Class）
决定与所标识目标相关的存储区的存在时间。

存储器模型 （Memory Model）
用于指定指向程序存储器的指针大小的描述。

存储器模型 （Memory Models）
表示可供应用程序使用的存储器。
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存储限定符 （Storage Qualifier）
表明所声明对象的特定属性 （例如 const）。

错误 （Errors）
错误报告导致无法继续处理程序的问题。 可能情况下，错误将标出问题所在的源文件
名和行号。

错误文件 （Error File）
包含由语言工具生成的错误消息和诊断信息的文件。

DSC

请参见数字信号控制器。

DSP

请参见数字信号处理器。

DWARF

使用任意记录格式调试。 DWARF 是 ELF 文件的调试信息格式。

带序列号的快速批量编程 （Serialized Quick Turn Programming）
序列化允许将序列号烧写到器件编程器要编程的每个单片机器件中。 此序列号可用作
入口码、密码或 ID 号。

单片机 （Microcontroller）
包含 CPU、 RAM、程序存储器、 I/O 端口和定时器的高度集成芯片。

单片机模式 （Microcontroller Mode）
PIC17 和 PIC18 单片机中的一种可能的程序存储器配置。 在单片机模式中，只允许内
部执行。 因此，在这种模式下仅可使用片内程序存储器。

导出 （Export）
以标准格式将数据发送出 MPLAB IDE。
导入 （Import）
从外面的源 （如 hex 文件）将数据送入 MPLAB IDE。
地址 （Address）
标识存储器中位置的值。

递归 （Recursion）
已定义的函数或宏可调用自己的概念。 当编写递归宏时要特别小心；当递归没有出口
时容易陷入无限循环。

递归调用 （Recursive Calls）
直接或间接调用自己的函数。

地址 （Address）
标识存储器中位置的值。

段 （Section）
位于存储器特定地址处的应用程序的一部分。

段属性 （Section Attribute）
用于描述段的特征 （例如 access段）。
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断点，软件 （Breakpoint, Software）
一个地址，固件会在这个地址处暂停执行。 通常由特殊的中断指令获得。

断点，硬件 （Breakpoint, Hardware）
一种事件，执行这种事件会导致暂停。

断点排序 （Sequenced Breakpoints）
按顺序发生的断点。 断点执行顺序是从下到上的；最先执行序列中的最后一个断点。

堆 （Heap）
用于动态存储器分配的存储区，在此存储区中，在运行时以任意顺序分配和释放存储
块。

堆栈，软件 （Stack, Software）
由应用程序用来存储返回地址、函数参数和局部变量的存储区。 当用高级语言开发代
码时，该存储区一般由编译器管理。

堆栈，硬件 （Stack， Hardware）
PIC 单片机中调用函数时存储返回地址的存储区。

EEPROM

电可擦除的可编程只读存储器。 一种可电擦除的特殊 PROM。 一次写或擦除一个数据
字节。 EEPROM 即使在电源关闭时也能保留内容。

ELF

可执行和链接格式。此格式的目标文件包含机器码。使用 DWARF 指定调试和其他信
息。 ELF/DWARF 可提供比 COFF 更好的优化代码调试。

Epilogue

编译器生成代码的一部分，负责释放堆栈空间、恢复寄存器及满足运行时模型中指定
的任何其他特定于机器的要求。这段代码在给定函数的任何用户代码之后、紧接着函
数返回之前执行。

EPROM

可擦除的可编程只读存储器。 通常可通过紫外线照射来擦除的可编程只读存储器。

二进制 （Binary）
使用数字 0-1 的以 2 为基数的计数体制。最右边的位表示 1 的倍数，右侧第二位表示
2 的倍数，再右侧第三位表示 22 = 4，以次类推。

FNOP

强制空操作。强制 NOP周期是双周期指令的第二个周期。 由于 PIC 单片机的架构是流
水线型，在执行当前指令的同时预取物理地址空间中的下一条指令。 但是，如果当前
指令改变了程序计数器，那么这条预取的指令就被忽略了，导致一个强制 NOP周期。

Free-Standing

一种接受任何不使用复杂类型的严格符合程序的实现，而且在这种实现中，对库条款
（ANSI 89 标准条款第 7 条）中规定的特性的使用，仅限于标准头文件 <float.h>、
<iso646.h>、 <limits.h>、 <stdarg.h>、 <stdbool.h>、 <stddef.h>和
<stdint.h>的内容。
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访问入口点 （Access Entry Points）
提供了一种方法，可将跨段控制传送到链接时可能未定义的函数。它们支持引导段和
安全应用段的独立链接。

仿真 （Emulation）
像执行存储在单片机中的固件一样执行装入仿真存储区中的软件的过程。

仿真存储器 （Emulation Memory）
调试器内包含的程序存储器。

放宽 （Relaxation）
将某一指令转换为相同但较小指令的过程。这有助于缩减代码大小。 MPLAB ASM30
目前知道如何将 CALL指令放宽 （RELAX）为 RCALL指令。当被调用的符号距当前
指令 +/- 32K 个指令字以内时可以这样做。

非扩展模式 （Non-Extended Mode）
在非扩展模式下，编译器不会使用扩展指令和立即数变址寻址模式。

非实时 （Non Real Time）
指处理器执行到断点或单步执行指令，或 MPLAB IDE 运行在软件模拟器模式。

非易失性存储 （Non-Volatile Storage）
电源关闭时保留其内容的存储器件。

符号 （Symbol）
符号是描述组成程序的不同部分的一种通用机制。 这些部分包括函数名、变量名、段
名、文件名和结构 / 枚举 / 联合标记名等。 MPLAB IDE 中的符号主要指变量名、函数
名和汇编标号。 链接后符号的值就是其在存储器中的值。

符号，绝对 （Symbol, Absolute）
表示立即值，例如通过汇编伪指令 .equ给出的定义。

GPR

通用寄存器。 器件数据存储器 （RAM）的一部分，作为一般用途。

高级语言 （High Level Language）
编写程序的语言，它比汇编语言更不依赖于具体的处理器。

跟踪 （Trace）
记录程序执行的调试器或软件模拟器功能。 调试器将程序执行记录到其跟踪缓冲区内，
并可上载到 MPLAB IDE 的跟踪窗口中。

跟踪存储区 （Trace Memory）
跟踪存储区包含在调试器内部。 跟踪存储区有时称为跟踪缓冲区。

跟踪宏 （Trace Macro）
一种可以提供调试器数据的跟踪信息的宏。 由于这是软件跟踪，所以必须把宏添加到
代码中，并对代码进行重新编译或重新汇编，必须在使用此代码编程目标器件后执行
跟踪。

工具栏 （Tool Bar）
一排或一列图标，可单击以执行 MPLAB IDE 功能。
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工作簿 （Workbook）
在 MPLAB SIM 软件模拟器中，指生成 SCL 激励的设置。

工作区 （WorkSpace）
工作区包含 MPLAB IDE 中关于选定器件、选定调试工具和／或编程器、打开的窗口及
其位置以及其他 IDE 配置设置的信息。

观察变量 （Watch Variable）
调试会话期间可在 Watch 窗口中监控的变量。

归档 （Archive）
可重定位目标模块的集合。 通过将多个源文件汇编为目标文件，然后使用归档器将目
标文件组合为一个库文件来生成。 可将库与目标模块和其他库链接，生成可执行代码。

归档器 （Archiver）
生成和操作库的工具。

国际标准化组织 （International Organization for Standardization）
制订许多行业和技术 （包括计算和通信）方面的标准的一个组织。

Halt （暂停）

停止程序执行。 执行 Halt 与在断点处停止相同。

Hex 代码 （Hex Code）
以十六进制格式代码存储的可执行指令。 Hex 代码包含在 hex 文件中。

Hex 文件 （Hex File）
包含适用于对器件编程的十六进制地址和值 （Hex 代码）的 ASCII 文件。

宏 （Macro）
宏指令。 以缩写形式表示指令序列的指令。

宏伪指令 （Macro Directive）
控制宏定义体中执行和数据分配的伪指令。

环回测试板 （Loop-Back Test Board）
用于测试 MPLAB ICD 3 在线调试器的功能。

环境－ IDE （Environment – IDE）
用于应用程序开发的特殊桌面布局。

环境－ MPLAB PM3 （Environment – MPLAB PM3）
包含关于如何对器件编程的文件的文件夹。 此文件夹可传送到 SD/MMC 卡。

汇编器 （Assembler）
把汇编源代码翻译成机器码的语言工具。

汇编语言 （Assembly Language）
以符号形式描述二进制机器码的编程语言。
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ICD

在线调试器。 MPLAB ICD 3 是 Microchip 在线调试器。

ICE

在线仿真器。 MPLAB ICE 2000 和 MPLAB ICE 4000 是 Microchip 在线仿真器。

ICSP

在线串行编程。一种通过使用串行通信并使用最少数量的器件引脚编程 Microchip 嵌入
式器件的方法。

IDE

集成开发环境。 MPLAB IDE 是 Microchip 集成开发环境。

IEEE

电气电子工程师协会。

IRQ

请参见中断请求。

ISO

请参见国际标准化组织。

ISR

请参见中断服务程序。

激励 （Stimulus）
软件模拟器的输入 （即为模拟对外部信号的响应而生成的数据）。 通常数据采用文本
文件中一系列动作的形式。 激励可以是异步的，同步的 （引脚），时钟激励和寄存器
激励。

机器码 （Machine Code）
处理器实际读和解释的计算机程序的表示。 二进制机器码的程序由一系列机器指令
（可能还包含数据）组成。 特定处理器的所有可能指令的集合称为 “指令集”。

机器语言 （Machine Language）
特定中央处理单元的指令集，不需翻译即可用于处理器。

基数 （Radix）
指数字基，十六进制或十进制，用于指定一个地址。

交叉引用文件 （Cross Reference File）
引用符号表的一个文件及引用符号的文件列表。 如果定义了符号，列出的第一个文件
是定义的位置。 其他文件包含对符号的引用。

校准存储区 （Calibration Memory）
用于保存 PIC 单片机内置 RC 振荡器或其他器件外设校准值的特殊功能寄存器或寄存
器。

节点 （Node）
MPLAB IDE 项目组件。

警告 （Warning）
一种警报，用于警告您出现了可能导致器件、软件文件或设备物理损坏的情形。
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警告 （Warning）
警告用于报告可能表明有问题的情形，但不暂停处理。 在 MPLAB C30 中，警告消息
报告源文件名和行号，但是包括文本 “warning:”以与错误消息区别开来。 
静态 RAM 或 SRAM （Static RAM or SRAM）

静态随机访问存储器。 目标板上可读 / 写且不需要经常刷新的程序存储器。

局部标号 （Local Label）
局部标号是用 LOCAL 伪指令在一个宏内部定义的标号。 这些标号特定于宏实例化的一
个给定示例。 也就是说，声明为 local 的符号和标号在遇到 ENDM 宏后不再可访问。

绝对段 （Absolute Section）
具有链接器不能改变的固定 （绝对）地址的段。

看门狗定时器 （Watchdog Timer）
PIC 单片机中在一段可选择长度的时间后复位处理器的定时器。 使用配置位来使能、
禁止和设置 WDT。
可重入函数 （Reentrant）
可以有多个同时运行的实例的函数。在下面两种情况下可能发生函数重入：直接或间
接递归调用函数；或者在中断处理过程中又执行此函数。

可重定位 （Relocatable）
其地址未被分配到固定的存储地址的目标。

可重定位段 （Relocatable Section）
地址不固定 （绝对）的段。 链接器通过称为重定位的过程将地址分配给可重定位段。

可执行代码 （Executable Code）
准备好被装入以执行的软件。

控制伪指令 （Control Directive）
汇编语言代码中根据汇编时指定表达式的值包含或忽略代码的伪指令。

库 （Library）
请参见归档。

库管理器 （Librarian）
请参见归档器。

快速存取存储区 （Access Memory）（仅 PIC18 系列器件）

PIC18 器件中的特殊寄存器，对这些寄存器的访问与存储区选择寄存器（Bank Select 
Register， BSR）的设置无关。

扩展单片机模式 （Extended Microcontroller Mode）
在扩展单片机模式中，既可使用片内程序存储器，也可使用外部存储器。 如果 PIC17
或 PIC18 器件的程序存储器地址大于内部存储空间，执行自动切换到外部存储器。

扩展模式 （Extended Mode）
在扩展模式下，编译器将使用扩展指令 （即 ADDFSR、 ADDULNK、 CALLW、 MOVSF、
MOVSS、 PUSHL、 SUBFSR和 SUBULNK）和立即数变址寻址。
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LVDS

低压差分信号。一种用于通过铜线进行高速 （每秒千兆位）数据传输的低噪声、低功
耗和小振幅方法。  
LVDS 与常规的输入 / 输出 （I/O）有以下几点不同： 
常规数字 I/O 认为 5V 为高电平（二进制 1）， 0V 为低电平（二进制 0）。 而使用差分
信号时，增加了第三种选择 （-5V）提供编码使用的附加电平，从而实现较高的最大
数据传输速率。

数据传输速率越高意味着需要的传输线越少，在 UW （Ultra Wide）和 UW-2/3 SCSI
硬盘中仅使用 68 条线。 短距离传输时，这些设备需要高传输速率。 使用标准 I/O 传输
时， SCSI 硬盘驱动器需要远不只 68 条线。 
低电压意味着标准的 5V 电压由 3.3V 或 1.5V 取代。

LVDS 使用双线系统，两条线间的相位差为 180 度。 这使得噪声以相同的电平传输，
从而可以被更容易和更有效地滤除。 
使用标准 I/O 信令，数据存储取决于实际电压。 电压可能受到传输线长度的影响 （线
越长，电阻就越高，从而使电压越低）。 但使用 LVDS 时，数据存储仅由电压的正负决
定，而不受电压值的影响。 因此，可在维持干净和一致的数据流的同时使数据传输得
更远。

来源： http://www.webopedia.com/TERM/L/LVDS.html。
链接描述文件 （Linker Script File）
链接描述文件是链接器的命令文件。定义链接选项并描述目标平台上的可用存储器。

链接器 （Linker）
合并目标文件和库以创建可执行代码、解析从一个模块到另一个模块的引用的语言工
具。

列表伪指令 （Listing Directive）
列表伪指令是控制汇编器列表文件格式的伪指令。 它们允许指定标题、对齐和其他列
表控制。

列表文件 （Listing File）
列表文件是列出为每条 C 源语句生成的机器码以及源文件中遇到的汇编指令、汇编伪
指令或宏的 ASCII 文本文件。

逻辑探针 （Logic Probe）
Microchip 的某些调试器最多可连接 14 个逻辑探针。 逻辑探针提供外部跟踪输入、触
发输出信号、 +5V 和公共接地端。

Makefile

导出到某个文件，此指令用于 Make 项目。使用该文件可在 MPLAB IDE 外 Make 项
目，即，使用 make 指令。

在 Project>Build Options>Project （项目 > 编译选项 > 项目）下， Directories （目 
录）选项卡上，为使用此功能必须在 “Build Directory Policy”（编译目录策略）下选
中 “Assemble/Compile/Link in the project directory”（在项目目录下进行汇编／编译
／链接操作）。

http://www.webopedia.com/TERM/L/LVDS.html
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Make 项目 （Make Project）
重新编译应用程序的命令，仅编译自上次编译完成后更改了的源文件。

MCU

单片机。 microcontroller 的缩写，也写作 µC。

MPASM™ 汇编器 （MPASM™ Assembler）
Microchip Technology 用于 PIC 单片机器件、 KeeLoq® 器件和 Microchip 存储器器件
的可重定位宏汇编器。

MPLAB ASM30

Microchip 用于 dsPIC 数字信号控制器和 PIC24 PIC 器件的可重定位宏汇编器。

MPLAB C 编译器 （MPLAB C Compilers）
指的是 Microchip 的 MPLAB C C 编译器：

• 用于 PIC18 MCU 器件的 MPLAB C 编译器 （以前称为 MPLAB C18）
• 用于 dsPIC 数字信号控制器和 PIC24 PIC 器件的 MPLAB C 编译器 （以前称为

MPLAB C30）
• 用于 PIC32MX MCU 的 MPLAB C 编译器 （以前称为 MPLAB C32）
MPLAB ICD 2

Microchip 的在线调试器，与 MPLAB IDE 配合工作。 ICD 支持带内置调试电路的闪存
器件。 每个 ICD 的主要组件为主机。 一个完整的系统由主机、仿真头板 （带有器件
ICD）、目标板、电缆和 MPLAB IDE 软件组成。

MPLAB ICD 3 在线调试器 （MPLAB ICD 3 In-Circuit Debugger）
Microchip 的在线调试器，与 MPLAB IDE 配合工作。 MPLAB ICD 3 调试器支持
PIC18F、 PIC24 MCU 和 dsPIC DSC。每个 ICD 的主要组件为主机。 一个完整的系统
由主机、驱动 （也可能包含接收器）卡、电缆和 MPLAB IDE 软件组成。

MPLAB ICE 2000

Microchip 的在线调试器，与 MPLAB IDE 配合工作。 MPLAB ICE 2000 支持 8 位 PIC 
MCU。 每个 ICE 的主要组件为主机。 一个完整的系统由主机、处理器模块、电缆和
MPLAB IDE 软件组成。

MPLAB ICE 4000

建议不要用于新设计。 请参见 MPLAB ICD 3 在线调试器。

Microchip 的在线调试器，与 MPLAB IDE 配合工作。 MPLAB ICE 4000 支持 PIC18F、
PIC24 MCU 和 dsPIC DSC。 每个 ICE 的主要组件为主机。 一个完整的系统由主机、
处理器模块、电缆和 MPLAB IDE 软件组成。

MPLAB IDE

Microchip 的集成开发环境。

MPLAB LIB30

MPLAB LIB30 归档器 / 库管理器是用于将由 MPLAB ASM30 或 MPLAB C30 C 编译器
生成的目标模块组合成库文件的目标库管理器。
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MPLAB LINK30

MPLAB LINK30 是 Microchip MPLAB ASM30 汇编器和 Microchip MPLAB C30 C 编译
器的目标链接器。

MPLAB PM3

Microchip 的器件编程器。可对 PIC18 单片机和 dsPIC 数字信号控制器编程。 可与
MPLAB IDE 配合使用，也可单独使用。 将淘汰 PRO MATE II。
MPLAB SIM

Microchip 的软件模拟器，与 MPLAB IDE 配合工作，支持 PIC MCU 和 dsPIC DSC 器
件。

MPLIB™ 目标库管理器 （MPLIB™ Object Librarian）
Microchip 的库管理器，与 MPLAB IDE 配合工作。 MPLIB 库管理器是用于将由
MPASM 汇编器（mpasm 或 mpasmwin v2.0）或 MPLAB C 编译器生成的 COFF 目标
模块组合成库文件的目标库管理器。

MPLINK™ 目标链接器 （MPLINK™ Object Linker）
MPLINK 链接器是 Microchip MPASM 汇编器和 Microchip MPLAB C 编译器的目标链
接器。 MPLINK 链接器还可与 Microchip MPLIB 库管理器配合使用。 MPLINK 链接器
设计为在 MPLAB IDE 中使用，尽管它也可独立于 MPLAB IDE 使用。

MRU

最近使用的。 指可从 MPLAB IDE 主下拉菜单选择的文件和窗口。

命令行接口 （Command Line Interface）
用户和程序之间仅基于文本输入和输出的一种通信方式。

模板 （Template）
为以后插入自己的文件中使用而创建的文本行。 MPLAB 编辑器将模板存储到模板文件
中。

目标 （Target）
指用户硬件。

目标板 （Target Board）
构成目标应用的电路和可编程器件。

目标处理器 （Target Processor）
目标应用板上的单片机。

目标代码 （Object Code）
由汇编器或编译器生成的机器码。

目标文件 （Object File）
包含机器码，也可能包含调试信息的文件。 它可以直接执行；或为可重定位的，需要
与其他目标文件 （如库文件）链接来生成完全可执行的程序。

目标文件伪指令 （Object File Directives）
仅在生成目标文件时使用的伪指令。
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目标应用程序 （Target Application）
目标板上的软件。

NOP

空操作。 执行该指令时，除了程序计数器加 1 外没有任何其他影响。

内部链接 （Internal Linkage）
如果不能从定义函数或变量的模块外部访问它们，则这样的函数或变量具有内部链接。

匿名结构 （Anonymous Structure）
未命名结构。

匿名结构 （Anonymous Structure）
指 C 联合成员中的未命名结构。 对匿名结构的成员的访问与访问包含该匿名结构的联
合的成员的方法相同。 例如，在下列代码中， hi 和 lo 是联合 caster 中匿名结构的成
员。

union castaway
 int intval;
 struct {
  char lo; //accessible as caster.lo
  char hi; //accessible as caster.hi
 };
} caster;

OTP

一次可编程。 非窗口封装的 EPROM 器件。 由于 EPROM 需要紫外线照射来擦除其存
储内容，因此只有窗口式器件是可擦除的。

PC

个人计算机或程序计数器。

PC 主机 （PC Host）
运行支持的 Windows 操作系统的任何 PC。

PIC MCU

PIC 单片机 （MCU）指所有 Microchip 单片机系列。

PICSTART Plus

Microchip 的开发器件编程器。 可对 8 引脚、 14 引脚、 28 引脚和 40 引脚 PIC 单片机
编程。 必须与 MPLAB IDE 软件配合使用。

Pragma

对特定编译器有意义的伪指令。 pragma 伪指令通常用来将实现定义的信息传达给编
译器。 MPLAB C30 使用属性来传达此信息。

PRO MATE II

不再生产。 请参见 MPLAB PM3 器件编程器。

Microchip 的器件编程器。 可对大多数 PIC 单片机、大多数存储器和 KEELOQ 器件进行
编程。 可与 MPLAB IDE 配合使用，也可单独使用。
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Prologue

编译器生成代码的一部分，负责释放堆栈空间、保存寄存器及满足运行时模型中指定
的任何其他特定于机器的要求。这段代码在给定函数的任何用户代码之前执行。

PWM 信号 （PWM Signal）
脉宽调制信号。 某些 PIC MCU 器件具有 PWM 外设。

跑表 （Stopwatch）
测量执行周期的计数器。

配置位 （Configuration Bit）
可编程来设置 PIC 单片机工作模式的专用位。 配置位可或不可再编程。

配置文件 （Profile）
MPLAB SIM 软件模拟器中寄存器的可执行激励的列表汇总。

片外存储器 （Off-Chip Memory）
片外存储器是指 PIC17 或 PIC18 器件的一种存储器选择，这种情况下存储器可位于目
标板上，或所有程序存储器都由调试器提供。 从 Options>Development Mode （选项
> 开发模式）进入的 Memory 选项卡提供 Off-Chip Memory selection （片外存储器选
择）对话框。

器件编程器 （Device Programmer）
用于对电可编程半导体器件 （如单片机）进行编程的工具。

嵌套深度 （Nesting Depth）
宏可包括其他宏的最大层数。

RAM

随机访问存储器 （数据存储器）。 可以以任意顺序访问这种存储器中的信息。

ROM

只读存储器 （程序存储器）。 无法修改该存储器。

Run

将调试器从暂停状态释放以允许它运行应用程序代码并实时更改或响应 I/O 的命令。

软件模拟器 （Simulator）
模拟器件操作的软件程序。

SFR

请参见特殊功能寄存器。

Shell

MPASM 汇编器 shell 是到宏汇编器的提示性输入接口。 有两个 MPASM 汇编器 shell：
一个是 DOS 版本，一个是 Windows 版本。

Single Step

这一命令单步执行代码，一次执行一条指令。 执行每条指令后， MPLAB IDE 更新寄存
器窗口、查看变量及状态显示，以便于分析和调试指令执行。 也可单步执行 C 编译器
源代码，但不是每次执行一条指令，MPLAB IDE 将执行一行高级 C 语句生成的所有汇
编指令。
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Skew

不同时间出现在处理器总线上与指令执行有关的信息。 例如，执行前一条指令的过程
中取指时，被执行的操作码出现在总线上；当实际执行操作码时，源数据地址及其值
以及目标数据地址出现在总线上。当执行下一条指令时，目标数据值出现在总线上。  
跟踪缓冲区一次捕捉总线上的这些信息。 因此，跟踪缓冲区的一条记录将包含三条指
令的执行信息。 执行一条指令时，从一条信息到另一条信息的捕捉周期数称为 skew。

Skid

当使用硬件断点来暂停处理器时，在处理器暂停前可能会再执行一条或多条指令。 断
点后执行的指令条数称为 skid。
SQTP

请参见带序列号的快速批量编程。

Step Into

这一命令与 Single Step 相同。 Step Into （与 Step Over 相对）在 CALL指令后，单步
执行子程序。

Step Out

Step Out 允许单步跳出您正在单步执行的子程序。 该命令执行子程序中代码的其余部
分，然后在子程序的返回地址处停止执行。

Step Over

Step Over 允许单步调试代码并在执行时跳过子程序。 当 step over 一条 CALL指令时，
下一个断点将设置在 CALL指令后的下一条指令处。 如果由于某种原因，子程序陷入
无限循环或返回不正确，下一个断点将永远执行不到。 除处理 CALL指令外， Step 
Over 命令和 Single Step 相同。

三字母组合 （Trigraphs）
三个字符组成的序列，均以 ?? 开头，由 ISO C 定义为单个字符的替代。

筛选器 （Filter）
在跟踪显示或数据文件中选择包括／不包括哪些数据来做出判断。

闪存 （Flash）
以块 （而不是以字节）为单位写或擦除数据的一种 EEPROM 类型。

上电复位仿真 （Power-on-Reset Emulation）
在开始为应用上电时，将随机值写到数据 RAM 区中来模拟 RAM 中未初始化值的软件
随机过程。

上载 （Upload）
上载功能将数据从一个工具 （如调试器或编程器）传送到主机 PC，或将数据从目标
板传送到调试器。

事件 （Event）
对可能包含地址、数据、次数计数、外部输入、周期类型 （取指和读 / 写）及时间戳
记的总线周期的描述。 事件用于描述触发、断点和中断。
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十六进制 （Hexadecimal）
使用数字 0-9 以及字母 A-F （或 a-f）的以 16 为基数的计数体制。 数字 A-F 表示十进
制值 10 至 15 的十六进制数字。最右边的位表示 1 的倍数，右侧第二位表示 16 的倍
数，右侧第三位表示 162 = 256，以此类推。

实时 （Real Time）
当在线调试器或调试器从暂停状态释放时，处理器以实时模式运行且与芯片的正常操
作相同。 在实时模式下，使能调试器的实时跟踪缓冲区，并持续捕捉所有选择的周期，
允许所有中断逻辑。 在在线调试器或调试器中，处理器实时执行，直到有效断点导致
暂停，或者直到用户暂停执行程序。

在软件模拟器中，实时仅意味着单片机指令的执行速度与主机 CPU 可模拟的指令速度
一样快。

实时观察 （Real-Time Watch）
在 Watch 窗口中，变量随着应用程序的运行而实时变化。 请参见相应的工具文档以确
定如何设置实时观察。 不是所有的工具都支持实时观察。

数据存储器 （Data Memory）
在 Microchip MCU 和 DSC 器件中，数据存储器 （RAM）由通用寄存器 （General 
Purpose Register， GPR）和特殊功能寄存器（Special Function Register， SFR）组
成。 某些器件还有 EEPROM 数据存储器。

数据伪指令 （Data Directive）
指控制汇编器的程序和数据存储空间分配，并提供通过符号 （即有意义的名字）引用
数据项的方法的数据伪指令。

书签 （Bookmarks）
使用书签很容易定位文件中的指定行。

在 Edit 菜单中，选择 Bookmarks 来管理书签。 可开关 （启用／禁用）书签、转到下
一个或上一个书签或清除所有书签。

属性 （Attribute）
C 程序中用于描述特定于机器的属性的变量或函数的特性。

属性，段 （Attribute, Section）
段的特性，如 “可执行”、“只读”或 “数据”，它们可在汇编器 .section伪指令
中指定为标记。

数字信号处理 （Digital Signal Processing）
对通常由模拟信号 （声音或图像）转换成数字形式 （采样）的数字信号进行的计算机
处理。

数字信号处理器 （Digital Signal Processor）
为处理数字信号而设计的微处理器。

数字信号控制器 （Digital Signal Controller）
具有数字信号处理功能的单片机器件，即 Microchip dsPIC DSC 器件。
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特殊功能寄存器 （Special Function Registers）
数据存储器 （RAM）的一部分，专用于控制 I/O 处理函数、 I/O 状态、定时器或其他
模式及外设的寄存器。

条件编译 （Conditional Compilation）
只有当预处理伪指令指定的某个常量表达式为真时才编译程序段的操作。

条件汇编 （Conditional Assembly）
基于汇编时指定表达式的值包含或忽略的汇编语言代码。

调试器 （Debugger）
执行仿真功能的硬件。

调试器系统 （Debugger System）

MPLAB ICE 2000 和 MPLAB ICE 4000 调试器系统包括主机、处理器模块、器件适配
器、目标板、电缆和 MPLAB IDE 软件。 PICkit 3 调试器系统由主机、驱动（也可能包
含接收器）卡、目标板、电缆和 MPLAB IDE 软件。

调试信息 （Debugging Information）
编译器和汇编器选项，选中时提供调试应用程序代码所需的多种信息。 请参见编译器
或汇编器文档，以了解选择调试选项的详细信息。

USB

通用串行总线。一种用于计算机和外设间通过双串行传输进行通信的外设接口标准。 
USB 1.0/1.1 支持 12 Mbps 的数据传输速率。 USB 2.0，也称为高速 USB，支持最大
480 Mbps 的数据传输速率。

Watch 窗口 （Watch Window）

Watch 窗口包含一系列观察变量，这些变量在每次执行到断点时更新。

WDT

请参见看门狗定时器。

外部 RAM （External RAM）

片外读 / 写存储器。

外部标号 （External Label）
有外部链接的标号。

外部符号 （External Symbol）
具有外部链接的标识符符号。 这可能是一个引用或一个定义。

外部符号解析 （External Symbol Resolution）
链接器搜集所有输入模块的外部符号定义来解析所有外部符号引用的过程。 没有相应
定义的任何外部符号引用都会导致报告链接器错误。

外部链接 （External Linkage）
如果某个函数或变量可以从定义它的模块外被引用，则称该函数或变量有外部链接。

外部输入线 （External Input Line）
用于根据外部信号设置事件的外部输入信号逻辑探针线 （TRIGIN）。
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微处理器模式 （Microprocessor Mode）
PIC17 和 PIC18 单片机中的一种可能的程序存储器配置。 在微处理器模式中，不使用
片内程序存储器。 整个程序存储器映射到外部。

未初始化数据 （Uninitialized Data）
定义时未提供初始值的数据。 在 C 中，

int myVar; 

定义了将存放到未初始化数据段的一个变量。

未分配段 （Unassigned Section）
在链接器命令文件中尚未分配给特定目标存储块的段。链接器必须找到一个可将未分
配段分配到的目标存储块。

伪指令 （Directives）
源代码中控制语言工具操作的语句。

文件寄存器 （File Register）
片内数据存储器，包括通用寄存器 （GPR）和特殊功能寄存器 （SFR）。

系统窗口控制 （System Window Control）
系统窗口控制位于窗口或某些对话框的右上角。 点击这一控制通常会弹出包含
“Minimize”（最小化）、“Maximize”（最大化）和 “Close”等项的菜单。

下载 （Download）
下载是数据从主机发送到其他器件 （如调试器、编程器或目标板）的过程。

限定符 （Qualifier）
次数计数器使用的地址或地址范围，或作为复杂触发中下一操作之前的事件。

向量 （Vector）
在发生复位或中断时应用程序跳转到的存储地址。

项目 （Project）
项目包含编译应用程序所需的文件 （源代码和链接描述文件等）及其与各种编译工具
和编译选项的关联。

小尾数法 （Little Endian）
多字节数据的数据存储顺序机制。在这种机制中，最低有效字节存储到较低的地址。

消息 （Message）
显示出来的文本，警告在语言工具的操作中可能存在的问题。 消息不会停止操作。

虚拟字节 （Phantom Byte）
dsPIC 架构中未实现的字节，用于将 24 位指令字当作 32 位指令字处理。虚拟字节出
现在 dsPIC hex 文件中。

延迟 （Latency）
事件及其响应之间的时间间隔。

样机系统 （Prototype System）

指用户的目标应用或目标板的一个术语。
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异步 （Asynchronously）
不同时发生的多个事件。 通常用于指处理器执行期间随时可能发生的中断。

异步激励 （Asynchronous Stimulus）
为模拟被模拟器件的外部输入而生成的数据。

一对一的项目－工作区模型 （One-to-One Project-Workspace Model）
在 MPLAB IDE 中，应用程序开发最常见的配置是一个工作区一个项目。 通过
Configure>Settings （配置 > 设置）选择 Projects （项目）选项卡并选中 “Use 
one-to-one project-workspace model”（使用一对一的项目－工作区模型）。

已分配段 （Assigned Section）
已分配给链接器命令文件中目标存储块的段。

应用 （Application）
可由 PIC 单片机控制的一组软硬件。

优先级 （Precedence）
用于定义表达式中求值顺序的规则。

“与”断点 （ANDed Breakpoints）
设置中断的 “与”条件，即断点 1 和断点 2 必须同时发生才能使程序暂停。 该功能只
能在数据断点和程序存储器断点同时发生时实现。

源代码 （Source Code）
编程人员编写计算机程序的形式。 采用某种正式的编程语言编写源代码，可翻译为机
器码或被解释程序执行。

原始数据 （Raw Data）
与段有关的代码或数据的二进制表示。

源文件 （Source File）
包含源代码的 ASCII 文本文件。

运算符 （Operator）
在生成定义完好的表达式时使用的加号 “+”和减号 “-” 之类的符号。 每个运算符都
分配了一个用于确定求值顺序的优先顺序。

运行时模型 （Run-time Model）
用于描述目标架构资源的使用。

帧指针 （Frame Pointer）
指向堆栈中地址的指针，它将基于堆栈的参数和基于堆栈的局部变量分隔开。提供了
一种方便的途径来访问当前函数的局部变量和其他值。

只读存储器 （Read Only Memory）
允许快速访问永久存储的数据但阻止添加或修改数据的存储硬件。

指令 （Instruction）
告知中央处理单元执行特定操作并包含操作中要使用的数据的位序列。
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指令集 （Instruction Set）
特定处理器理解的机器语言指令的集合。

致命错误 （Fatal Error）
导致编译立即暂停的错误。 不产生其他消息。

中断 （Interrupt）
传递到 CPU 的信号，它使 CPU 暂停执行正在运行的应用程序，把控制权转交给中断 
服务程序 （ISR），以处理事件。 ISR 执行完毕后，应用程序继续正常执行。

中断处理程序 （Interrupt Handler）
发生中断时处理特殊代码的子程序。

中断服务程序 （Interrupt Service Routine）
处理中断的函数。

中断服务程序 （Interrupt Service Routine）
当产生中断时进入的用户生成代码。 代码在程序存储器中的位置通常取决于所产生中
断的类型。

中断请求 （Interrupt Request）
使处理器暂停正常的指令执行并开始执行中断处理程序的事件。 某些处理器有几种中
断请求事件，允许具有不同优先级的中断。

中断向量 （Interrupt Vector）
中断服务程序或中断处理程序的地址。

中央处理单元 （Central Processing Unit）
器件的一部分，负责取出要执行的正确指令，对指令进行译码，然后执行指令。需要
时，它和算术逻辑单元 （ Arithmetic Logic Unit， ALU）配合工作，来完成指令的执
行。它控制程序存储器地址总线、数据存储器地址总线和对堆栈的访问。

主机 （Pod）
MPLAB REAL ICE 系统： 包含用于仿真头板或目标板上的 ICE 器件的仿真控制电路的
机箱。 ICE 器件可以是包含内置 ICE 电路的生产器件或生产器件的特殊 ICE 版本
（即，器件 -ICE）。

MPLAB ICD 2/3： 包含用于仿真头板或目标板上的 ICD 器件的调试控制电路的机箱。 
ICD 器件可以是包含内置 ICD 电路的生产器件或生产器件的特殊 ICD 版本 （即，器件
-ICD）。

MPLAB ICD 2000/4000： 包含仿真存储器、跟踪存储器、事件定时器和周期定时器以
及跟踪／断点逻辑的外部调试器机箱。

助记符 （Mnemonics）
直接翻译成机器码的文本指令。 也称作操作码。

状态栏 （Status Bar）
状态栏位于 MPLAB IDE 窗口的底部，指示光标位置、开发模式和器件，以及有效工具
栏等当前信息。



PICkit™ 3 用户指南

DS51795A_CN 第 90 页  2009 Microchip Technology Inc.

字节存储顺序 （Endianess）
多字节对象的字节存储顺序。

字母字符 （Alphabetic Character）
字母字符指属于阿拉伯字母表 （a, b, …, z, A, B, …, Z）中字母的字符。

字母数字字符 （Alphanumeric）
字母数字字符由字母字符和十进制数字 （0， 1， …， 9）组成。

左值 （L-value）
引用可被检查和 / 或修改的对象的表达式。 l-value 表达式用在赋值语句的左侧。
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